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Глава 13 
Управление Привязками 
В этой главе Вы изучите как зависимости, называемые еще отношениями родитель / 
потомок, создаются между различными объектами и элементами в Pro/ENGINEER. 

Цели 
После завершения этой главы, Вы научитесь: 

• создавать зависимости родитель / потомок. 

• Находить зависимости в конструкции путем исследования деталей и сборок. 

• Управлять зависимостями между компонентами. 

Определение Отношений Родитель / Потомок 

В процессе проектирования в Pro/ENGINEER, между объектами часто создаются зависимости, 
называемые отношениями родитель / потомок (parent/child relationships). 

Для создания эффективных зависимостей в создаваемой модели и избежания нежелательных 
зависимостей, необходимо познакомится с терминологией Pro/ENGINEER, относящейся к отношениям 
родитель / потомок: 

• Привязка (Reference) � элемент, используемый для определения отношений между двумя 
объектами в процессе размещения или образмеривания элемента в сборке. 

• Внешняя ссылка (External reference) � объект, используемы системой для размещения или 
образмеривания элемента, который находится в другой модели, вне текущей модели. 

• Зависимость (Dependency) � отношение между объектом и другим, ссылочным объектом 
(referenced entity). 

Преимущества Проектирования с Использованием Внешних Ссылок 
Создание внешних ссылок имеет много преимуществ, например: 

• элементы конструкции, которые в целом соответствуют назначению конструкции при 
размещении, образмеривании и привязке в сборке. 

• Создание таких отношений между моделями, при которых изменения в одной модели влекут 
автоматические изменения в других. 

• Легкое копирование геометрии из одной модели в другую. 

• Консолидированный контроль над геометрией в скелетной модели (ях), при котором 
выполненные изменения передаются в компоненты, которые на нее ссылаются. 

Создание Зависимостей 
В следующей таблице перечислены различные способы, которыми можно создавать отношения 
родитель / потомок в модели конструкции. 
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Таблица 1: Создание Отношений Родитель / Потомок 

Действие Зависимости 

Выбрать плоскость эскиза и плоскость привязки 

Образмерить или привязать существующую 
геометрию 

Использовать зависимость Align 

Использовать Edge или Offset Edge. 

Создать концентричные дуги или окружности 
только при выборе существующей геометрии. 

Использовать опции глубины, которые требуют 
выбирать привязки типа поверхности, кромки, 
опорного элемента или точки (Up to Curve, Up to 
Point, Up to Surface, and Thru Until). 

Выбрать привязки размещения и образмеривания 
для элементов выбора и размещения. 

Между двумя элементами в процессе создания 
детали 

Использовать Dependent при копировании 
элемента. 

Собрать компонент с другими компонентами в 
сборке (компонент начинает зависеть от 
размещения других компонентов в пределах 
сборки) 

Между двумя компонентами в сборке 

Используйте Mirror, Merge или Cutout для 
создания зависимости между компонентами, но 
не в сборке (одна деталь зависит от другой 
детали в части геометрии) 

Создать или изменить элементы детали и 
привязки других компонентов для эскизной 
плоскости, горизонтальной или вертикальной 
плоскости привязки, размерных привязок, 
привязок выравнивания и т.д. 

Создать элемент на уровне сборки и сделать его 
видимым на уровне детали, или использовать 
опцию New Names на уровне сборки. 

Между компонентом и сборкой 

Создать элемент на уровне сборки и привязать 
компонент в процессе создания элемента. 

Исследование Существующих Объектов 

Перед проведением конструктивных изменений в модели, созданной другим пользователем, 
необходимо познакомится с деталью или сборкой и определить, как она была построена. Для 
исследования существующих объектов, можно использовать любой из следующих трех инструментов: 

Выпадающее Меню Info 
Можно использовать опцию Info для получения информации относительно регенерации, 
зависимостей, компонентов, модели и Спецификации (BOM). 

• Информация по регенерации (Regeneration Information). 
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• Родитель / потомок (Parent/Child). 

• Компонент (Component). 

• Модель (Model). 

• Спецификация (BOM). 

Инструмент Дерева Модели 
Инструмент Дерева модели позволяет использовать динамическую обратную связь в процессе 
создания объекта в режиме Детали и Сборки. Этот инструмент показывает только регенерированные 
объекты в их соответствующем порядке по умолчанию; однако, можно настроить формат для 
соответствия потребностям пользователя. Можно вызывать информацию по модели, используя 
выпадающее меню TREE. 

 
Рисунок 1: Инструмент Дерева Модели (Отдельное Окно) 

Глобальный Просмотрщик Привязок 
Для идентификации внутренних и внешних привязок в детали или сборке, можно запрашивать модель, 
используя Глобальный Просмотрщик Привязок (Global Reference Viewer). 
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Рисунок 2: Глобальный Просмотрщик Привязок 

Список Привязок Родитель / Потомок 
Используя инструмент Глобального Просмотрщика Привязок, можно перечислять родительские или 
дочерние привязки компонентов или элементов, которые имеют внутреннюю и-или внешнюю ссылку 
на активный объект. 

Для установки различных объектов, выберите элемент, компонент или сборку; затем щелкните по 
Actions > Set Current. Используя диалоговое окно PARENT AND CHILD REFERENCES, можно 
исследовать выбранную привязку для определения следующего: 

• родительских или дочерних привязок, появляющихся при создании элементов с внешними 
ссылками. 

• Модели, которые имеют отношения родитель/потомок. 

• Зависимостей размещения, которые создают отношения родитель/потомок. 

Ограничение Объема Информации 

Используя FILTER SETTINGS, можно определять перечень информации, предоставляемый 
Глобальным Просмотрщиком Привязок. Его можно настраивать для отображения: 

• компонентов, которые требуется отобразить в исходном дереве. 

• Типа привязки. 

• Объектов, которые имеют родительские отношения, в отличии от объектов, которые имеют 
дочерние привязки. 

Определение Иерархии Отношений 
Используя Глобальный Просмотрщик Привязок, можно также определять иерархию привязок, 
связанных с моделью. 

 
Рисунок 3: Иерархия Отношений 

Управление Взаимозависимостями 

Используя Utilites > Reference Control, можно определять пределы для создания привязок к другим 
моделям в рабочей сессии Pro/ENGINEER. 

Установка Объектно-Ориентированного Управления Привязками 
При указании установок фильтра и схемы управления привязками индивидуально для каждого 
объекта, система сохраняет информацию с объектом и применяет ее для каждой сборки, в которой 
появляется объект. 

Диалоговое окно REFERENCE CONTROL можно вызывать, используя любой из следующие способов. 
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Таблица 2: Вызов Диалогового Окна REFERENCE CONTROL. 

Метод: Действие: 
Для конкретной детали или скелета Щелкните по Part Setup > Ref Control 

Для детали в сборке Щелкните по Modify > Mod Part > Ref Control 

Для скелета в сборке Щелкните по Modify > Mod Skel > Ref Control 

Для подсборки Щелкните по Modify > Mod Subasm > Design Mgr 
> Ref Control 

Для сборки верхнего уровня в активном окне 
сборки 

Щелкните по Assembly > Design Mgr > Ref 
Control 

Из Дерева Модели Выберите любой объект правой кнопкой мыши; 
затем щелкните по Ref Control в выпадающем 
меню 

Настройки Управления Привязками 
Для указания возможностей, можно выбирать настройки из диалогового окна REFERENCE CONTROL. 

 
Рисунок 4: Диалоговое Окно REFERENCE CONTROL 

Опции Reference Handling определяют поведение системы при попытке создания внешней ссылки, 
которая нарушает определенные условия. Selection Feedback Settings обеспечивают цветовую 
обратную связь для привязок, вышедших за диапазон и опции выбора для привязок вне диапазона. 
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Обратите внимание: 
При открытии модели, которая содержала оригинальную привязку и которая была удалена или 
подавлена, система переходит в Среду Разрешения Конфликта, даже если имеются локальные 
резервные (backup) копии ссылок. 

Использование Элементов Копирования Геометрии для Отслеживания и Управления 
Внешними Ссылками 
Используя опцию Copy Geom, можно легко отслеживать и управлять внешними ссылками, объединяя 
их в один элемент копирования геометрии. 

При изменении элемента Dependency в элементе, можно указать, должна ли система отображать в 
копии изменения, сделанные в исходной модели. 

Обратите внимание: 
При сборке компонентов в узел в сборке верхнего уровня, можно указать привязки сборки (из 
зависимостей) которые находятся вне узла в котором проводилась сборка. При вызове узла в сессию 
без сборки верхнего уровня, размещение компонента приводит к конфликту по причине отсутствия 
привязок. 

Лабораторный Практикум 

Цель 
В этом практикуме, Вы исследуете модель для определения того, как она была построена и 
для идентификации отношений родитель / потомок. 

Метод 
В Упражнении 1, Вы используете глобальный просмотрщик привязок для изучения модели. Также 
будут использованы опции Reroute и Redefine для изменения привязок. 

В Упражнении 2, Вы изучите головную деталь для определения того, как она была построена и 
идентифицируете отношения родитель / потомок некоторых элементов. 

В Упражнении 3, Вы изучите сборку передней подвески для определения того, как она была построена 
и идентифицируете наложенные зависимости. 

УПРАЖНЕНИЕ 1: Изменение Поршня 
Задача 1. Изучить модель для определения зависимостей элементов. Определить, как она 
регенерируется. 

1. Перейдите в соответствующий рабочий каталог. 

2. Откройте PISTON_PC.PRT. 

3. Изучите порядок регенерации. Щелкните по Info > Model в меню. Обратите внимание, что элементы 
перечисляются в порядке создания. Закройте окно. 

4. Щелкните по Info > Regen Info для регенерации модели по одному элементу за раз. 

Обратите внимание: 
Опция Regen Info доступна только в меню высшего уровня. Если оно не доступно, закройте меню на 
высшем уровне (то есть, PART или ASSEMBLY). 

5. Щелкните по Beginning > Continue для прохода элемент за элементом. При достижении 
последнего элемента, система автоматически выходит из операции Regen Info. 
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Совет: 
Для получения более подробной информации по регенерации элементов, щелкните по Info Feat для 
отображения информации по элементу или по Show Dims для отображения размеров, используемых 
для создания элемента. 

Задача 2. Использовать Дерево Модели для исследования модели с целью определения, как была 
построена деталь. 
1. Щелкните по Utilites > Customize Screen > Options > Display as separate window > OK. 
2. Распахните все объекты. 

Совет: 
Для назначения имен важным элементам следует использовать Setup > Name. 

 
Рисунок 5: Распахнутое Дерево Модели 

Задача 3. Изучить первый элемент выреза для идентификации всех отношений родитель / потомок. 

1. Щелкните и удерживайте правую кнопку мыши на ROD_PIN_HOLE в Дереве Модели. Щелкните по 
Info > Parent/Child Info. 

2. Просмотрите REFERENCE INFORMATION WINDOW. 

Задача 4. Изучите индивидуальные привязки. 

1. Система перечисляет DTM3, потому что это привязка эскизной плоскости для элемента. Щелкните 
по + рядом с PROTRUSION ID 7. 
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Рисунок 6: Окно Reference Information 

2. Выберите SURFACE ID 13. Эта подсвеченная поверхность является ссылочной плоскость. Также 
обратите внимание, что на AXIS A_1 тоже ссылаются. 

3. Выберите EDGE ID 12 и обратите внимание на привязку размера к верхней передней кромке 
поршня. Щелкните по Close. 

Совет: 
Следует избегать выбора кромок в качестве привязок, если можно выбрать копланарную поверхность 
в модели. Это более точно соответствует размеру до верхней поверхности поршня. 

 
Рисунок 7: Поршневая Модель 

Задача 5. Изменить размерную привязку для точеного отверстия под палец от кромки поверхности. 

1. Щелкните и удерживайте правую кнопку мыши на ROD_PIN_HOLE в Дереве Модели. Щелкните по 
Reroute > Yes для отката назад по истории. 
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2. Прочитайте сообщение в области сообщений и примите существующую эскизную плоскость. 
Щелкните по Same Ref. 
3. Щелкните по Same Ref для принятия нижней горизонтальной привязки. 

4. После подсвечивания AXIS A_1, щелкните по Same Ref. 
5. Щелкните по Alternate. Выберите верхнюю поверхность поршня. 

Задача 6. Вспомните, что ориентирующей привязкой модели являлось основание поршня, тогда как 
размерной привязкой был верх поршня. Это нежелательные отношения родитель / потомок. Измените 
привязку. 

1. Щелкните и удерживайте правую кнопку мыши на ROD_PIN_HOLE в Дереве Модели. Щелкните по 
Redefine. 

2. Измените сечение. Дважды щелкните по Section в диалоговом окне. Щелкните по Sketch Plane. 

3. Щелкните по Same Ref для сохранения DTM3 в качестве эскизной плоскости. 

4. Оставьте ALTERNATE по умолчанию. Щелкните по Top, затем по DTM2. 

Задача 7. Завершить переопределение элемента. Система переходит в режим Эскиза. Pro/ENGINEER 
автоматически регенерирует сечение для определения его корректности. 

1. Щелкните по  > ОК. 

Обратите внимание: 
Главное различие между переопределением и перенаправлением эскизной и ссылочной плоскости в 
том, что переопределение автоматически вызывает диалоговое окно. Во избежание регенерации 
эскиза, щелкните по Reroute. 

2. [Необязательно] Используйте опции информации, изученные ранее для проверки привязок 
родитель / потомок. 

3. Сохраните файл и сотрите его из оперативной памяти. 

УПРАЖНЕНИЕ 2: Разрыв Внешних Ссылок 
Задача 1. Рекомендуется определять, как была построена модель перед проведением в ней каких 
либо изменений. Исследуйте, как была создана головка блока цилиндров. 

1. Вызовите HEAD_PC.PRT. 

 
Рисунок 8: Головка Блока Цилиндров 



Pro/ENGINEER 2001 Углубленный Курс    

- 298 - 

2. Щелкните по Info > Regen Info для регенерации модели по одному элементу за раз. Щелкните по 
Beginning > Continue для прохода элемент за элементом. По достижении последнего элемента, 
система автоматически выходит из операции Regen Info. 

Обратите внимание: 

Не следует проходить через элементы, используя Continue. При нажатии Quit, система выполнит всю 
регенерацию модели. 

Задача 2. Используйте меню Info для исследования модели и определения зависимостей элементов. 

1. Щелкните по Info > Global Ref Viewer. 
2. Просмотрите индивидуальные привязки элементов, как показано на следующем рисунке. Щелкните 
по Feature в колонке REF TYPE. Выберите FILTER SETTING для ее распахивания. Щелкните по All в 
колонке REF EXTENT. Щелкните по All Objects в колонке DISPLAYED OBJECTS диалогового окна. 
Дважды щелкните по GASKET_MOUNT, чтобы сделать его текущим объектом. 

 
Рисунок 9: Глобальный Просмотрщик Привязок 

3. Обратите внимание, что этот элемент имеет внешнюю родительскую привязку к ENGINE_PC.ASM. 

4. Идентифицируйте все элементы, которые имеют внешние ссылки на другие детали. Щелкните по 
Feature > External > All Objects в выпадающем списке FILTER SETTING. Глобальный Просмотрщик 
Привязок отображает только элементы с внешними ссылками. 
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Рисунок 10: Отображение Элементов с Внешними Ссылками 

Задача 3. Переопределите элемент GASKET_MOUNT, чтобы он стал независимым от сборки. 

1. Откройте ENGINE_PC.ASM. 

2. Переопределите вырез GASKET_MOUNT. Щелкните по Modify > Mod Part. Выберите HEAD_PC из 
Дерева Модели. 
3. Щелкните по Feature > Redefine. Выберите элемент прокладки, используя Дерево Модели. При 
использовании Дерева Модели, щелкните по Tree > Item Display > Features. 
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Рисунок 11: Прокладка в Дереве Модели 

4. Щелкните по Master Rep > OK. 

5. Дважды щелкните по Section в диалоговом окне; затем щелкните по Sketch. 

6. Щелкните по Sketch > References в меню. Выберите все привязки в диалоговом окне. Щелкните по 
Delete. 

7. Укажите привязки осевых линий к опорным элементам детали. Выберите DTM3 и DTM2. Щелкните 
по Close. 

8. Добавьте два диаметральных размера и горизонтальный размер, как показано на следующем 
рисунке. 

 
Рисунок 12: Размеры Эскиза для Прокладки 

9. После успешной регенерации сечения, щелкните по  > ОК в диалоговом окне. 
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10. Сохраните и сотрите сборку из памяти. 

11. Активизируйте окно HEAD_PC.PRT. 

12. Используйте REFERENCE VIEWER, чтобы убедиться в том, что система удалила внешние ссылки 
для этого элемента. Щелкните по Info > Global Ref Viewer. 
13. Настройте опции фильтра для отображения внешних ссылок элемента. Щелкните по Feature > 
External > All Objects в списке FILTER SETTING. Дважды щелкните по HEAD_PC.PRT. Диалоговое 
окно содержит только компоненты с элементами, имеющими внешние ссылки. Обратите внимание, 
что HEAD_PC.PRT не имеет никаких внешних родительских ссылок. 

 
Рисунок 13: Диалоговое Окно Global Reference Viewer 

14. Сохраните и сотрите модель из памяти. 

УПРАЖНЕНИЕ 3: Изучение Сборки Подвески 
Задача 1. Изучить сборку для определения порядка ее регенерации. 

1. Откройте PC_SUSPENSION.ASM. 
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Рисунок 14: Передняя Подвеска 

2. Изучите порядок, в котором компоненты в сборке регенерируются. 

Задача 2. Изучить сборку для идентификации привязок между компонентами и определения того, как 
компоненты были собраны. 

1. Щелкните по Info > Component в меню. Выберите PC_SHOCK_RF.ASM. 

2. Для идентификации ссылочных объектов, выберите первую зависимость ALIGN в диалоговом окне. 
Сборочная привязка, AXIS A_17, подсвечивается пурпурным. Привязка компонента, AXIS A_2, 
подсвечивается голубым. 

3. Выберите две другие зависимости и наблюдайте, которые компоненты подсвечиваются на экране. 
Закройте диалоговое окно. 

Задача 3. Используйте GLOBAL REFERENCE VIEWER для исследования информации по компоненту. 

1. Щелкните по Info > Global Ref Viewer в меню. В диалоговом окне REFERENCE VIEWER; щелкните 
по Component > All > All Objects. 

2. Дважды щелкните по PC_SHOCK_RF.ASM. Обратите внимание, что PC_FRNT_SKEL.PRT - 
родительская привязка. Вспомните, что ось A_17 является выравнивающей привязкой для сборки 
компонента. 

Совет: 
Можно использовать Highlight в выпадающем меню TREE диалогового окна GLOBAL REFERENCE 
VIEWER для выбора элемента или компонента и подсвечивания его на экране. 

Задача 4. Используйте Глобальный Просмотрщик Привязок для изучения информации по модели. 
Определите, почему имеется внешняя ссылка между PC_WISHBONE.PRT и PC_WHEEL.ASM. 
Повторите процесс для PC_KNUCKLE_LF.PRT. 

1. Щелкните по Feature в колонке REF TYPE. 

2. Дважды щелкните по PC_WISHBONE.PRT в Главном Дереве. 

3. Щелкните правой кнопкой мыши по PC_WHEEL.ASM; затем щелкните по Info. INFORMATION 
WINDOW поясняет, что этот компонент является частью взаимозаменяемой сборки. Закройте окно. 

4. Измените текущую модель. Распахните PC_WHEEL_HUB_LF.ASM используя пиктограмму +. 
Дважды щелкните по PC_KNUCKLE_LF.PRT. 

5. Обратите внимание, что этот компонент имеет родительские привязки вне этой сборки. Щелкните 
правой кнопкой мыши по PC_KNUCKLE_RF.PRT. 
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6. Щелкните по Full Path. Деталь PC_KNUCKLE_LF была создана как зеркальное отображение 
компонента PC_KNUCKLE_RF, показанного на следующем рисунке. 

 
Рисунок 15: Деталь PC_KNUCKLE_LF 

 
Рисунок 16: Деталь PC_KNUCKLE_RF 

7. [Необязательно] Используйте GLOBAL REFERENCE VIEWER для исследования других 
компонентов внутри сборки передней подвески, а также для определения того, какие привязки были 
установлены и как они были установлены. 

8. Сохраните и сотрите всю сборку по завершении. 

Резюме 

В этой главе, Вы узнали что: 

• Отношения Родитель / потомок являются составной частью процесса конструирования. 
Следует учитывать воздействие вниз по дереву сборки при установке привязок. 

• Меню Конструирования (Design Manager) � важный инструмент, который позволяет 
контролировать то, какие привязки следует оставить, а какие требуется изменить или удалить. 

• Глобальный Просмотрщик Привязок (Global Reference Viewer) является тем инструментом, 
который следует использовать первым при работе с чужой моделью. 
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Глава 14 
Проектирование - Часть 1: 
Назначение Проекта 
Это первая из трех основных стадий в процессе проектирования сверху-вниз, в которой 
Вы предоставите всю критическую информацию проекта без пошаговых инструкций. 

Основное назначение Части 1 состоит в передаче назначения конструкции и создании 
структуры изделия. 

Цели 
В этой главе Вы выполните следующее: 

• зафиксируете исходные параметры проекта и назначение конструкции в Pro/ENGINEER, 
используя компоновку (layout). 

• Создадите исходную структуру изделия в режиме Сборки. 

Описание Проекта и Требования 

Сценарий 
Вы являетесь инженером на Фабрике Вентиляторов Faneuil (F3), известной проектной и 
производственной компании в Штате Массачусетс. 

F3 участвует в создании нового изделия бытового назначения в конце текущего финансового 
квартала. Создание вентиляторов индивидуального использования является новым сегментом рынка 
для F3, поскольку ранее они работали только на промышленном рынке. 

Оперативная разработка интеллектуальных моделей в Pro/ENGINEER является критической для 
непрерывного успеха в F3. Внутри, проект называется VORTEX-1200, самый новый вариант семейства 
F3 популярного коммерческого ряда VORTEX систем управления воздухом. 

Цели Проекта VORTEX 1200 
Цель проекта состоит в создании гибкой модели сборки для поворотного настольного вентилятора 
(показанного на следующих рисунках) с использованием методов проектирования сверху-вниз. 
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Рисунок 1: Конечная Модель Вентилятора 

 
Рисунок 2: Вид Сзади Сборки Вентилятора 

 
Рисунок 3: Покомпонентный Вид Сборки Вентилятора 
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Рисунок 4: Компоновочная Информация Вентилятора 

 
Рисунок 5: Таблица Компоновки 

Требования к конструкции 
Для группы разработчиков изделия в F3 определен следующий список требований и параметров. 

• Модель Вентилятора должна помещаться в контейнер 12x12x15 для перевозки и снижения 
габаритов. 

• Вентилятор использует стандартный электродвигатель F3 ¼ HP на 110 В с управляемым 
редуктором (gearbox Drivetrain Assembly) как на VORTEX-1800. 
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• Вентилятор должен быть совместим с лопастями типа 3, 4 и 5. Окончательное решение 
группой конструкторов еще не было принято. 

• Используемые лопасти не должны превышать безопасный диаметр сетчатой корзины 11 
дюймов и глубину 2.75 дюйма. 

• В соответствии со стандартами F3 диаметр лопастей определяется диаметром сетчатой 
корзины. Величина зазора между вершиной лопасти и корзиной [0.5]. 

• Прибор должен иметь полный угол осцилляции не менее 45°. 

• Высота вентилятора должна легко изменяться от основания до оси наклона и от оси наклона 
до основной оси. Исходные значения [2.125] и [4.25] соответственно. Высота оси наклона 
может быть значительно увеличена для напольного варианта. 

• Прибор может наклоняться в вертикальной плоскости на 90° для настенного варианта. 

• Основание вентилятора должно иметь «объемный» вид, в соответствии с последними 
требованиями потребителей. Кроме того, общий дизайн вентилятора должен быть выполнен в 
стиле «ретро». 

• Прибор должен быть смоделирован без проводов и электрических разъемов. Отверстие 
диаметром [0.50] (может изменяться) должно находиться с левой стороны заднего корпуса для 
подвода электрики. Через него будут подводиться провода и устанавливаться стандартный 
переключатель F3. переключатель управляет питанием вентилятора, а также может 
включать/выключать осцилляцию при помощи запатентованной, монтируемой в редуктор, 
электромуфты. 

• Все узлы являются стандартными изделиями, разработанными в лаборатории F3. Поэтому их 
не требуется моделировать или собирать на этом этапе разработки. 

Лабораторный Практикум 

Цель 
В этом практикуме, Вы передадите исходные конструктивные параметры и назначение 
конструкции средствами Pro/ENGINEER и, затем, разработаете исходную структуру 
изделия. 

Метод 
В Упражнении 1, Вы используете компоновку Pro/ENGINEER для передачи исходных проектных 
параметров и назначения конструкции. 

В Упражнении 2, Вы воплотите исходную структуру изделия в сборке. 

УПРАЖНЕНИЕ 1: Воплощение Начального Назначения Конструкции 
Задача 1. Подготовьтесь к работе над проектом и создайте файл компоновки. 

1. Очистите оперативную память и перейдите в рабочий каталог PROJECT. 

2. Создайте новую компоновку с именем VORTEX-1200.LAY. Используйте опции EMPTY и C-SIZE. 

Задача 2. Настроить компоновку для эскиза. 

1. Установите следующие настройки Эскиза. 
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Рисунок 6: Диалоговое Окно SKETCH PREFERENCES 

2. Установите Draft Grid в [0.250]. 

3. Включите опцию Parametric Sketch. 

Задача 3. Создать геометрию компоновки. 

1. Создайте двухмерную геометрию приблизительно так, как показано на следующем рисунке. 
Габаритный размер приблизительно 8" в ширину и 12" в высоту. 

 
Рисунок 7: Создание Двухмерной Геометрии 

Задача 4. Добавить детали. 

1. Добавьте размеры и оси. На запрос значения, введите пока [0]. 
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Рисунок 8: Добавление Размеров и Осей 

Задача 5. Создать таблицы модифицируемых параметров. 

1. Создайте таблицу и заполните только заголовки, как показано на следующем рисунке. 

2. Создайте параметры для всех значений, которые не являются размерами, кроме BLADE_DIA. 
Установите значения, показанные в таблице. 

3. Создайте отношение: 
blade_dia = cage_dia – (blade_clearance*2)

4. Введите значения в колонке PARAMETER как простой текст. Пример: MAX_HEIGHT 

5. Введите значения в колонке VALUE как параметрические примечания. Пример: &MAX_HEIGHT  

6. Заполните таблицу и измените значения, как показано в следующем рисунке. 

 
Рисунок 9: Критические Технические Требования 
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Задача 6. Завершить компоновку. 
1. Закончите компоновку, как показано на следующем рисунке. 

 
Рисунок 10: Компоновочная Информация 

2. Сохраните компоновку и закройте окно. 

УПРАЖНЕНИЕ 2: Разработка Исходной Структуры Изделия 
Задача 1. Создать новую сборку и структуру изделия. 

1. Создайте новую Сборку по имени VORTEX-1200, используя шаблон по умолчанию. 

2. Используя Дерево Модели, создайте показанную структуру, используя исходные модели в каталоге 
PROJECT и зависимости по умолчанию. 
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3. Компоненты с символом  - стандартные включенные F3_MODELS. 

 
Рисунок 11: Дерево Модели 
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Глава 15 
Проектирование - Часть 2: 
Скелетный Проект 
В части два Проектирования Сверху-Вниз, Вы сосредоточитесь на создании 
интеллектуальной скелетной модели. Скелет включает базовые скелетные элементы, 
перемещения, требования к размещению и интерфейсы. 

Цели 
В этой главе Вы выполните следующее: 

• создадите базовые скелетные элементы. 

• Создадите скелетные элементы для перемещения. 

• Создадите скелетные элементы увязки (space claims). 

• Создадите скелетные элементы для стыковки (interfaces). 

УПРАЖНЕНИЕ 1: Создание Основного Скелета 
Задача 1. Открыть скелетную деталь и создать исходные элементы. 

1. Откройте модель VORTEX-1200_SKEL. 

2. Переименуйте опорный элемент ТОР. Щелкните по Setup > Name. Введите [GROUND]. Создайте 
эскизную опорную кривую, как показано на следующем рисунке. Введите [POST_CRV] в качестве 
названия кривой. 

 
Рисунок 1: Начало Эскизирования 

3. Нарисуйте опорную кривую на плоскости GROUND. (Или используйте файл BASE.SEC). Введите 
[BASE_CRV] в качестве названия кривой. 
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Рисунок 2: Эскизная Кривая 

4. Создайте плоскость TILT_REF через вершину POST_CRV, как показано на следующем рисунке. 

 
Рисунок 3: Эскиз Через Вершину Кривой POST_CRV 

5. Создайте ось TILT и плоскость TILT_ANG. 

 
Рисунок 4: Создание Оси TILT и Плоскости TILT_ANG 

6. Создайте плоскости INTERFACE и MAIN_DRIVE со смещением от TILT_ANG, как показано на 
следующем рисунке. 
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Рисунок 5: Плоскость со Смещением от Угла Tilt 

7. Создайте плоскость TILT_PERP через ось TILT и нормальную к плоскости TILT_ANG, как показано 
на следующем рисунке. 

8. Пересмотрите атрибуты для Fit Feature и выберите плоскость INTERFACE. 

 
Рисунок 6: Выбор Плоскости Интерфейса 

9. Сместите плоскость TILT_PERP на 1.50 для создания плоскости PIVOT_REF, как показано на 
следующем рисунке. Переопределите атрибуты для Fit Feature и выберите плоскость INTERFACE. 
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Рисунок 7: Смещенная Плоскость 

10. Создайте ось PIVOT в месте пересечении PIVOT_REF и FRONT. 

 
Рисунок 8: Создание Оси Pivot 

11. Сохраните модель 

УПРАЖНЕНИЕ 2: Скелетные Элементы Перемещения 
Задача 1. Создать опорные элементы, которые будут функционировать в качестве фиксированной 
точки присоединения для связывания элементов (linkage) на кронштейне. 

1. Создайте эскизную опорную кривую на плоскости INTERFACE, используя PIVOT_REF в качестве 
привязки RIGHT. Используйте только ось PIVOT в качестве ссылки в эскизе и переименуйте кривую в 
FIXED_CRV. 

Обратите внимание: 
В этой главе, несколько рисунков были созданы с некоторыми опорными плоскостями, скрытыми с 
помощью опции Hide для ясности. 
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Рисунок 9: Ось Поворота в Качестве Привязки 

2. Создайте опорную точку на ближайшей вершине только что созданной кривой. 

3. Создайте ось Through (Через) точку и Normal (Перпендикулярно) плоскости INTERFACE. 
Переименуйте ось в LINK_FIXED. 

 
Рисунок 10: Создание Оси 

Задача 2. Создать опорные кривые для представления рычага (linkage). 

1. Создайте эскизную опорную кривую, показанную ниже на плоскости INTERFACE, используя 
PIVOT_REF в качестве привязки RIGHT. Используйте только оси PIVOT и LINK_FIXED в качестве 
привязок в Эскизе, и переименуйте кривую на LINKAGE. Нарисуйте 3 линии и конструктивную 
окружность. 

 
Рисунок 11: Эскиз 

2. Используя колесико прокрутки, установите значение угла в пределах от 5 до 355°. Кривая должна 
свободно перемещаться в направлении осцилляции. 
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3. Создайте YES/NO PARAMETER с именем OSCILLATE. Установите исходное значение в YES. 

4. Установите опцию конфигурации, как показано на следующем рисунке. 

 
Рисунок 12: Установка Опции Конфигурации 

5. Щелкните по Relations > . Выберите опорную кривую и обратите внимание на номер размера 
d31 в нашем примере. Затем введите отношение, как показано на следующем рисунке. 

 
Рисунок 13: Отношение 

6. После выхода из RELATIONS EDITOR, несколько раз регенерируйте модель, чтобы проверить 
действие редактирования. Верните рычаг в исходное положение приблизительно к 85°. 

Обратите внимание: 
Для последующего использования, параметр OSCILLATE может быть переключен в YES или NO для 
включения или выключения вращения рычага. 

7. Создайте другую эскизную кривую, используя те же привязки, как показано на следующем рисунке. 
Назовите эту кривую RT_ANG_CRV. (Нарисуйте две линии). 

 
Рисунок 14: Создание Эскизной Кривой 

Задача 3. Создать дополнительный опорный элемент, используя рычаг в качестве привязки. 

1. Создайте плоскость через кривую и через ось поворота (pivot), как показано на следующем рисунке. 
Назовите плоскость MAIN_FRONT и измените ее размеры в соответствии с элементами 
RT_ANG_CRV. 
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Рисунок 15: Создание Плоскости 

2. Создайте плоскость MAIN_PERP через ось поворота (pivot) перпендикулярно плоскости 
MAIN_FRONT, как показано на следующем рисунке. 

 
Рисунок 16: Создание Плоскости 

3. Создайте ось с именем MAIN в месте пересечения плоскостей MAIN_DRIVE и MAIN_FRONT, как 
показано на следующем рисунке. 

 
Рисунок 17: Создание Оси 

4. Создайте элемент опорной точки с именем LINKAGE_PTS в вершине рычага, как показано на 
следующем рисунке. 
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Рисунок 18: Создайте Элемент Опорной Точки 

5. Создайте две оси через предыдущие точки и перпендикулярные к плоскости INTERFACE. 

 
Рисунок 19: Обозначение Осей 

6. Создайте систему координат в месте пересечения плоскостей MAIN_DRIVE, MAIN_PERP и 
MAIN_FRONT. Ориентируйте оси, как показано на следующем рисунке. 

 
Рисунок 20: Ориентирование Осей 

7. Удалите все слои по умолчанию и создайте три новых слоя для управления отображением многих 
скелетных элементов. 
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Рисунок 21: Создайте Трех Слоев 

8. Сохраните модель. 

УПРАЖНЕНИЕ 3: Скелетные Элементы для Пространственной Увязки 
ОБРАТИТЕ ВНИМАНИЕ: 
При использовании завершенной версии этого скелета, сначала откроется сборка Drivetrain, чтобы 
элемент псевдографики регенерировался должным образом. 

Задача 1. Создайте пространственную увязку (space claim) для основания, используя выдавленную 
поверхность. 

1. Создайте выдавленную поверхность, используя опорную кривую BASE, как показано на следующем 
рисунке. Используйте опцию Capped Ends и выдавите вверх на 2.0. 

 
Рисунок 22: Выдавливание Поверхности 

Задача 2. Создайте пространственную увязку для ранее созданной F3 сборки drivetrain, используя 
внешний элемент псевдографики. 

1. Откройте и изучите сборку DRIVETRAIN. Затем закройте окно. 
2. Щелкните по Insert > Shared Data > Shrinkwrap from Other Model > Open. Выберите 
F3_DRIVETRAIN.ASM. 
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3. Щелкните по Coord Sys > Sel By Menu > dt_main > Select. Затем выберите систему координат 
SKEL_MAIN. 

4. Увеличьте Quality Level до  и установите . Затем щелкните по Done > ОК. 

 
Рисунок 23: Выбор Системы Координат 

Задача 3. Создать пространственную увязку для сетчатой корзины и лопастей вентилятора. 

1. Создайте выдавленную поверхность, используя опции Both Sides и Open Ends. Выберите 
поверхность в качестве эскизной плоскости и используйте опорный элемент INTERFACE в качестве 
привязки ТОР, как показано на следующем рисунке. 

 
Рисунок 24: Выбор Эскизной Плоскости 

2. Нарисуйте окружность диаметром 11.0, как показано на следующем рисунке. 
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Рисунок 25: Эскиз Окружности 

3. Используйте Blind для выбора глубины и введите [1.375]. 

 
Рисунок 26: Глухая (Blind) Глубина 

Задача 4. Проверить работу скелета. 

1. Проверьте осцилляцию скелета, регенерируя через полный оборот рычага, 360°. 

2. Проверьте действие угла наклона, изменяя плоскость TILT_ANG на 45°. Затем измените на 90°. 

3. Проверьте осцилляцию при 90°. Затем верните плоскость TILT_ANG назад к 15°. 

4. Переименуйте три поверхности увязки на BASE_CLAIM, DRIVE_CLAIM и BLADE_CLAIM 
соответственно. Добавьте эти элементы к слоям BASE и FAN соответственно. 

УПРАЖНЕНИЕ 4: Скелетные Элементы для Интерфейсов 
ОБРАТИТЕ ВНИМАНИЕ: 
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При использовании завершенной версии этого скелета, сначала откроется сборка Drivetrain, чтобы 
элемент псевдографики регенерировался должным образом. 

Задача 1. Создать первый интерфейс между основанием и кронштейном. 

1. Установите отображение слоя, как показано на следующем рисунке. 

 
Рисунок 27: Установка Отображения Слоя 

2. Создайте плоскую поверхность на плоскости FRONT, используя GROUND в качестве привязки ТОР 
и ось TILT в качестве только привязки Эскиза, как показано на следующем рисунке. 

 
Рисунок 28: Ось Tilt в Качестве Только Привязки 

Задача 2. Создать второй интерфейс между сборками основания и вентилятора в месте оси pivot. 

1. Создайте плоскую поверхность на плоскости INTERFACE, используя FRONT в качестве привязки 
bottom и оси PIVOT и LINK_FIXED в качестве только привязки Эскиза, как показано на следующем 
рисунке. 

 
Рисунок 29: Создание Плоской Поверхности 

2. Назовите две интерфейсные поверхности BASE_INTF и PIVOT_INTF соответственно, и добавьте 
только поверхность BASE_INTF на слой BASE. 

Задача 3. Создать интерфейс между рукояткой двигателя и шарниром. 

1. Установите отображение слоя, как показано на следующем рисунке. 
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Рисунок 30: Установка Статуса Слоя 

2. Создайте плоскую поверхность, используя опцию Use Prev. Используйте ось AUX_ARM только как 
привязку в Эскизе, как показано на следующем рисунке. 

 
Рисунок 31: Создание Плоской Поверхности 

3. Назовите поверхность TEMP. 

4. Сместите поверхность TEMP вверх на 0.125. Назовите поверхность смещения ARM_LINK_INTF. 

5. Добавьте поверхность TEMP на слой BASE, а поверхность ARM_LINK_INTF на слой LINKAGE. 

6. Отобразите все слои. 

 
Рисунок 32: Смещение Поверхности Temp 

7. Измените плоскость TILT_ANG на 0° и проверьте осцилляцию скелета. Обратите внимание, что 
лопасти находятся очень близко к основанию. Измените высоту BASE_CLAIM на 1.25. 

Обратите внимание: 
Обратите внимание, что один интерфейс всегда остается постоянным (BASE_INTF), один 
наклоняется, но не осциллирует (PIVOT_INTF) и один наклоняется и осциллирует (ARM_LINK_INTF). 

8. Возвратите плоскость TILT_ANG к 15°. 

9. Сохраните модель. 
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Глава 16 
Проектирование - Часть 3: Создание 
Окончательной Сборки 
В Части 3 Проектирования, Вы изучите связь геометрической и параметрической 
информации и заполнение сборки. 

Цели 
В этой главе Вы изучите следующее: 

• передачу компоновочной информации в скелет. 

• Передачу скелетной информации в компоненты. 

• Создание компонентов, используя скелетную информацию. 

• Заполнение сборки существующими компонентами. 

УПРАЖНЕНИЕ 1: Сообщение Компоновочной Информации в Скелет 
Задача 1. Объявить скелет в компоновке и, затем, связать некоторые из параметров компоновки со 
скелетными размерами. 

1. Откройте Компоновку, затем откройте Скелет. 

2. Щелкните по Setup > Declare > Declare Lay > Vortex-1200. 

3. Изменить POST_CRV и выберите размер 3.50. 

4. На запрос о значении размера, введите [tilt_axis_height] и щелкните по Yes. 

5. Повторите процедуру для параметра MAIN_HEIGHT. 

6. Повторите для параметра INTERFACE. 

7. Повторите для параметров CAGE_DIA и CAGE_DEPTH. 

8. Повторите для параметра TILT_ANG. 

Обратите внимание: 
Другие параметры Компоновки будут объявлены позже в проекте. 

Важное Замечание: 
Эти конструктивные модули характеризуют передачу данных от моделей скелета к детали. 

Модели деталей, созданные в этой главе, не обязательно должны соответствовать показанным на 
рисунках. Но интерфейсы между смоделированными компонентами должны взаимодействовать 
должным образом. 

Если Вы ограничены по времени, то можно: 

1. Создать модели деталей с меньшим количеством и более простыми элементами, чем показано. 

2. Собрать законченные модели в скелет. 
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УПРАЖНЕНИЕ 2: Передача Информации и Создание Элементов 
Задача 1. Сообщить скелетную геометрию в модель. 

1. Откройте сборку высшего уровня. 

2. Выберите деталь MAIN_BASE из Дерева Модели и переопределите ее. Обратите внимание на 
зависимость по умолчанию. Так как это - постоянный компонент, можно оставить зависимость по 
умолчанию. 

3. Выберите деталь MAIN_BASE из Дерева Модели. Щелкните по  > Feature > Create > Data 
Sharing > Copy Geom. 

4. Используя опции Surface Refs, Curve Refs и Misc Refs соответственно, выберите геометрию, как 
показано на следующем рисунке. 

 
Рисунок 1: Выбор Геометрии 

5. Создайте второй элемент Copy Geom, ссылающийся на большую поверхность BASE_CLAIM. 

ОБРАТИТЕ ВНИМАНИЕ: 
Для этого проекта, геометрия передается непосредственно из скелета в модели деталей, даже если 
они фактически являются узлами. 

Если зависимость класса времени не использовалась, лучше сначала передать геометрию в другие 
скелеты на каждом уровне подсборок и, затем, снова передать в отдельные модели. 

Задача 2. Создать основные элементы в форме столба. 

1. Откройте деталь MAIN_BASE и скройте Copy Geom поверхности BASE_CLAIM. 

2. Создайте выдавливание, привязанное к круглой интерфейсной поверхности, и выдавите обе 
стороны, как показано на следующем рисунке. 

 
Рисунок 2: Создание Выдавливания 
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3. Создайте вырез, привязанный к поверхности интерфейса. 

 
Рисунок 3: Создание Выреза 

4. Создайте другой вырез, привязанный к интерфейсной поверхности и полное скругление. 

 
Рисунок 4: Создание Выреза и Полного Скругления 

5. Скруглите заднюю сторону. 

 
Рисунок 5: Скругленная Задняя Сторона 

6. Добавьте скругление переменного радиуса на передней стороне. (Подсказка: в верхней точке 
скругления используется опорная точка). 

 
Рисунок 6: Переменный Радиус 

Задача 3. Создайте выдавленную поверхность, чтобы слить ее с BASE_CLAIM. 

1. Создать выдавленную поверхность, используя сплайн, как показано на следующем рисунке. 
Убедитесь, что она выходит за границы поверхности BASE_CLAIM по ширине и глубине. 
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Рисунок 7: Выступание Выдавленной Поверхности 

2. Объедините (Merge) эту поверхность с поверхностью BASE_CLAIM. 

 
Рисунок 8: Слияние Поверхностей 

3. Создайте скругление переменного радиуса. 

 
Рисунок 9: Радиус Переменного Скругления 

4. Создайте базовое твердотельное выдавливание используя существующую лоскутную поверхность. 

5. Добавьте окончательное скругление и скройте все не используемые слои. 

6. В каталоге PROJECT сохранена палитра цветов. Загрузите файл PROJECT_COLORS.MAP. 

7. Закрасьте все поверхности, используя определенное отображение LT_BROWN. 

 
Рисунок 10: Закраска Поверхностей 

8. Сохраните модель и закройте окно. 

УПРАЖНЕНИЕ 3: Передача Информации и Создание Элементов в Детали 
Support_Arm 

Задача 1. Сообщить скелетную геометрию в модель. 

1. Откройте сборку высокого уровня. 
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2. Выберите деталь SUPPORT_ARM из Дерева Модели и переопределите ее. Обратите внимание на 
зависимость по умолчанию. Так как она является перемещающимся компонентом, зависимость по 
умолчанию принимать нельзя. 

3. Удалите зависимость по умолчанию. 
4. Добавить три зависимости Align Coincident между плоскостями FRONT, TOP и RIGHT детали и 
плоскостями FRONT, TILT_ANG и TILT_PERP в скелете, соответственно. 

5. Выберите деталь SUPPORT_ARM из Дерева Модели. Щелкните по  > Feature > Create > Data 
Sharing > Copy Geom. 

6. Используя Surface Refs и Misc Refs соответственно, выберите геометрию, 2 поверхности и 2 оси, 
как показано на следующем рисунке. 

 
Рисунок 11: Выбор Геометрии 

7. Откройте SUPPORT_ARM и создайте два выдавливания, привязанных к поверхности интерфейса, 
как показано на следующем рисунке. 

 
Рисунок 12: Создание Выдавливаний, Привязанных к Интерфейсным Поверхностям 

8. Затем, создайте две плоские опорные кривые. Каждая создается на плоскости, смещенной по 
отношению к соседней геометрии. 
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Рисунок 13: Создание Плоских Опорных Кривых 

9. Создайте ряд общих сопряжений, выбирая сечения. Используйте опцию Tangency для сглаживания 
переходов. 

 
Рисунок 14: Создание Сопряжения 

10. Создайте скругления в нижней части модели. 

 
Рисунок 15: Создание Скруглений 

11. Создайте сквозной вырез и два глухих отверстия, привязанных к интерфейсной геометрии. 
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Рисунок 16: Создание Выреза и Глухих Отверстий 

12. Скройте все неиспользуемые слои и закрасьте все поверхности, используя определенное 
отображение LT_BROWN. 

 
Рисунок 17: Закраска Поверхностей 

13. Сохраните модель. 

УПРАЖНЕНИЕ 4: Передача Информации и Создание Элементов в Связанной 
Детали 

Задача 1. Сообщить скелетную геометрию в модель. 

1. Откройте сборку высокого уровня и, затем, откройте Скелет. 

2. Создайте Систему Координат, используя опцию 2Axes. Выберите ось и кривую. Выберите Y > X, как 
показано на следующем рисунке. Щелкните по Done. 

 
Рисунок 18: Выбор Оси и Кривой 

3. Переименуйте элемент в LINK_CSYS. 
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Рисунок 19: Переименование Элемента 

4. Откройте окно со сборкой высокого уровня. 

5. Выберите деталь LINK из Дерева Модели и переопределите ее. Как только она станет 
перемещающимся компонентом, удалите зависимость по умолчанию. 

6. Добавьте зависимость CoordSys между LINK_CSYS в скелете и Csys по умолчанию в детали LINK. 

7. Создайте элемент Copy Geom в связывающей детали, 2 оси и 3 поверхности, как показано на 
следующем рисунке. Откройте модель. 

 
Рисунок 20: Создание Элемента Copy Geom в Рычаге 

8. Создайте выдавливание, привязанное к элементу Copy Geom, как показано на следующем рисунке. 

 
Рисунок 21: Создание Выдавливания 

9. Создайте два отверстия, привязанных к Copy Geom. 

 
Рисунок 22: Создание Отверстий 

10. Скройте все не используемые слои и закрасьте деталь, используя отображение DK_GREY. 

 
Рисунок 23: Закраска Детали 

11. Сохраните модель. 
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УПРАЖНЕНИЕ 5: Передача Информации и Создание Элементов в Детали 
Drive_Arm 

Задача 1. Сообщить скелетную геометрию в модель. 

1. Откройте сборку высокого уровня и, затем, откройте Скелет. 

2. Создайте Систему координат, используя опцию 2Axes. Выберите показанные ось и кривую, затем 
щелкните по Y > X > Done, как показано на следующем рисунке. 

 
Рисунок 24: Выбор Оси и Кривой 

3. Переименуйте элемент в ARM_CSYS. 

4. Откройте окно сборки высокого уровня. 

5. Выберите деталь ARM из Дерева Модели и переопределите ее. Удалите зависимость по 
умолчанию и добавьте зависимость COORDSYS между ARM_CSYS в скелете и CSYS по умолчанию в 
детали DRIVE_ARM. 

6. Создайте элемент Copy Geom в детали DRIVE_ARM, состоящий из геометрии, 3 поверхностей и 2 
осей, как показано на следующем рисунке. 

7. Откройте модель. 

 
Рисунок 25: Создание Элемента Copy Geom в Детали Двигателя Arm 

8. Создайте выдавливание, привязанное к Copy Geom, как показано на следующем рисунке. 

 
Рисунок 26: Создание Выдавливания 

9. Создайте второе выдавливание. 
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Рисунок 27: Создание Второго Выдавливания 

10. Создайте вырез, используя опцию Use Quilt, и второй вырез, привязанный к Copy Geom. 

 
Рисунок 28: Создание Вырезов 

11. Скройте все не используемые слои и закрасьте деталь, используя отображение LT_GREY. 

12. Сохраните модель. 

 
Рисунок 29: Окончательная Деталь 

УПРАЖНЕНИЕ 6: Передача Информации и Создание Элементов в Детали 
Housing_Rear 

Задача 1. Сообщите скелетную геометрию в модель. 

1. Откройте сборку высокого уровня. 

2. Выберите деталь HOUSING_REAR из Дерева Модели и переопределите ее. Удалите зависимость 
по умолчанию. Добавьте зависимость COORDSYS между SKEL_MAIN Csys в скелете и Csys по 
умолчанию в детали HOUSING_REAR. 

3. Создайте элемент Copy Geom в детали HOUSING_REAR, состоящий из этих двух поверхностей и 
оси, как показано на следующем рисунке. 
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Рисунок 30: Создание Элемента Copy Geom в Детали Заднего Кожуха 

4. Откройте модель HOUSING_REAR. 

 
Рисунок 31: Модель Заднего Кожуха 

5. Щелкните по Insert > Surface Operation > Transform > Mirror > No Copy > Done. 
6. Выберите поверхность кольца. Щелкните по Done Sel. Выберите плоскость FRONT. Обратите 
внимание, что поверхностьухможно эффективно отобразить на другую сторону плоскости. 

 
Рисунок 32: Поверхность, Отображенная на Другую Сторону 

ОБРАТИТЕ ВНИМАНИЕ: 
Если преобразованная поверхность имеет пазы, создайте сверху копию поверхности в виде простого 
выдавливания, как показано выше. Затем, скройте исходную поверхность с пазами для последующих 
операций в упражнении. 
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7. Выполните вращение поверхности, состоящей из кривой 2-го порядка и маленькой вертикальной 
линии, как показано на следующем рисунке. 

 
Рисунок 33: Поверхность Вращения 

8. Обратите внимание, что вертикальная линия смещается на 0.0625 наружу от прямоугольной 
скопированной геометрии, которая составляет толщину материала. 

9. Выполните слияние этих две поверхностей вместе. 

10. Вернитесь в сборку и обратите внимание, что вспомогательный вал проходит через кожух. 
Создайте второй элемент Copy Geom в заднем кожухе, содержащий геометрию, показанную на 
следующем рисунке. 

 
Рисунок 34: Создание Copy Geom  

11. Вернитесь в окно детали. Создайте широкую поверхность, которая со всех сторон выходит за 
кожух. 

12. Сместите поверхность наружу на 0.10, как показано на следующем рисунке. 

 
Рисунок 35: Смещение Поверхности 
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13. Выберите новую поверхность смещения. Обрежьте поверхность, используя опцию Use Quilt. 
Скройте скопированную и смещенную трубчатые поверхности. 

 
Рисунок 36: Выбор Новой Поверхности Смещения 

14. Вставьте Thin Protrusion с использованием опции Use Quilt. Придайте толщину наружу внутрь 
на 1/16". 

15. Завершите модель добавлением отверстия 1/8" и трех наборов вентиляционных пазов. 

16. Скройте все не используемые слои и закрасьте деталь. Сохраните модель. 

 
Рисунок 37: Завершенные Детали 

УПРАЖНЕНИЕ 7: Заполнение Сборки 
Задача 1. Собрать drivetrain. 

1. Откройте сборку высокого уровня и скройте скелет. 

 
Рисунок 38: Сборка Высокого Уровня без Скелета 
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2. Проверьте корректность сборки, регенерируя ее несколько раз. 

3. Переопределите сборку DRIVETRAIN. Добавьте зависимость COORD SYS, как единственную 
зависимость между DT_MAIN Csys в Drivetrain и SKEL_MAIN Csys в скелете. 

 
Рисунок 39: Переопределенная Сборка 

Задача 2. Собрать ступицу и лопасти. 

1. Откройте сборку DRIVETRAIN. 

 
Рисунок 40: Сборка Drivetrain 

2. Регенерируйте сборку несколько раз и проследите за вращением карданного вала (driveshaft). Это 
выполняется путем сборки карданного вала на наклонном опорном элементе и с использованием 
отношений, аналогичных рычагу (linkage). 

3. Закройте сборку DRIVETRAIN и вернитесь в сборку высокого уровня. 

4. Переопределите F3_HUB и соберите, как показано на следующем рисунке. Плоская поверхность на 
валу должна использоваться в процессе сборки, чтобы ступица вращалась вместе с валом. 
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Рисунок 41: Сборка Ступицы 

5. Переопределите включенный F3_BLADE и соберите с использованием зависимости Csys между 
Csys по умолчанию в F3_BLADE и Csys на ведущем ушке (leader ear) массива F3_HUB. 

 
Рисунок 42: Переопределение и Сборка Лопастей 

6. Привяжите массив лопастей вокруг ступицы. 

 
Рисунок 43: Массив Привязанных Лопаток 

Задача 3. Собрать сетчатую корзину. 

1. Переопределите деталь F3_CAGE-11 и соберите, как показано на следующем рисунке. Используйте 
зависимость INSERT для центрирования проволочных петель корзины с отверстиями в крышке. Затем 
используйте зависимость TANGENT для совмещения впотай корзины с крышкой. 
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Рисунок 44: Сборка Корзины 

2. Сохраните сборку. 

3. Установите параметр параметр OSCILLATE в скелете в NO. Проверьте вращение ступицы и 
лопастей путем регенерации. 

4. Установите параметр OSCILLATE в скелете в YES. Проверьте полное движение сборки. 

5. Сохраните сборку. 

УПРАЖНЕНИЕ 8: Последние Штрихи 
Следующие задачи необязательны. Выполните их столько, на сколько хватит времени, в 
любом порядке. 

Обзор следующих задач: 
1. Обрезать лопасти для совмещения с корзиной. 

2. Изменить количество лопастей, используя компоновку. 

3. Завершить заднюю крышку. 

4. Завершить основание. 

5. Завершить кронштейн. 

6. Создать подставку. 

7. Использовать BMX для проверки угла осцилляции. 

8. Наклонить модель и изменить конструкцию. 

9. Создать покомпонентное изображение. 

10. Проверить габаритные размеры. 

Задача 1. Обрезать лопасть для соответствия размерным требованиям. 

1. Откройте скелет и создайте поверхность, как показано на следующем рисунке. 

Подсказка: создайте эскиз в верхней части вала двигателя и выдавите Both Sides. 

2. Переименуйте поверхность в BLADE_DIA_SRF. 
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Рисунок 45: Создание Поверхности 

3. Свяжите эти два размера с параметрами Компоновок BLADE_DIA и CAGE_DEPTH соответственно. 

4. Вызовите скелет. Откройте сборку, и обратите внимание что лопасти выходят за поверхности 
BLADE_DIA_SRF. 

 
Рисунок 46: Завышенные по размерам Лопасти 

5. Используйте Copy Geom для копирования BLADE_DIA_SRF в первую лопасть и откройте лопасть. 

 
Рисунок 47: Первая Лопасть 

6. Переупорядочьте новый элемент Copy Geom над элементом выреза Blade_OUTLINE. 

7. Измените элемент опорной точки RIDGE_POINTS для изменения кривизны выступа, как показано на 
следующем рисунке. 
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Рисунок 48: Изменение Кривизны Выступа 

8. Переопределите вырез BLADE_OUTLINE. Измените эскиз сплайна, чтобы он остался в пределах 
поверхности BLADE_DIA_SRF. 

 
Рисунок 49: Переопределенный Вырез Лопатки 

9. Завершите переопределение выреза. Добавьте новый Copy Geom на слой ALL_SURFS и скройте 
все слои. 

10. Сохраните лопасть и вернитесь в сборку. Обратите внимание на то, что BLADES теперь находятся 
в пределах указанного зазора. Скройте скелет. 
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Рисунок 50: Скорректированный Зазор Лопастей 

Задача 2. Сообщить параметр NUM_BLADES. 

1. Сообщите параметр компоновки NUM_BLADES в параметр массива в F3_HUB. (Ступица и сборка 
высокого уровня должны быть задекларированы (declare)). Подсказка: откройте ступицу и запишите 
отношение, аналогичное: 

P49 = NUM_BLADES. 

2. Измените параметр NUM_BLADES в компоновке на 4. Регенерируйте сборку. 

 
Рисунок 51: Регенерированная Сборка 
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Задача 3. Создайте последние элементы геометрии на задней крышке. 

1. Поверните копию пазов на правой стороне (RIGHT) на заднюю (REAR) крышку, 90° для создания 
пазов на стороне ТОР. 

 
Рисунок 52: Создание Пазов 

2. Создайте отверстие для подвода питания, создавая цилиндрическую поверхность в скелете, 
копируя эту поверхность на крышку и используя ее для выреза. См. следующие два рисунка. 

 
Рисунок 53: Создание Отверстия для Подвода Проводов 

3. Свяжите диаметр цилиндра, используемого для создания отверстия, с параметром компоновки 
ELEC_HOLE_DIA. 

Задача 4. Завершить деталь основания. 

1. Добавьте три протянутых выдавливания, формирующих художественные ребра на основании. 

 
Рисунок 54: Создание Художественных Ребер 

Задача 5. Завершить кронштейн. 

1. Добавьте скругление к кронштейну, как показано на следующем рисунке. 
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Рисунок 55: Скругление Кронштейна 

Задача 6. Создать подставку. 
1. Увеличьте масштаб отображения под вентилятором. Обратите внимание, что фактически не 
имеется никакой модели, соединяющей сборку вентилятора с SUPPORT_ARM. 

2. Используя собственные методы, создайте модель называемую pedestal (подставкой). Ее 
необходимо создавать в контексте соответствующего узла и использовать методы проектирования 
сверху-вниз для создания геометрии. 

3. Одна из возможностей для этой модели показана на следующих рисунках. 

 
Рисунок 56: Создание Подставки 

 
Рисунок 57: Возможная Форма Подставки 

Задача 7. Проверить сборку на соответствие исходным требованиям проекта по углу осцилляции, 
используя Поведенческое Моделирование (BMX). 

1. Сохраните сборку высокого уровня и создайте копию скелета. Назовите его SKEL_ANALYSIS. 
(Можно использовать сохраненный SKEL_ANAL) 

2. Откройте SKEL_ANALYSIS. 

3. Создайте опорный элемент анализа, который измеряет угол от плоскости MAIN_FRONT до 
плоскости FRONT и выдает результаты в параметр ANGLE. 
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4. Войдите в редактор уравнений и удалите подсвеченную опцию, показанную на следующем рисунке. 
Обратите внимание на номер углового размера (d31 в этом примере). 

 
Рисунок 58: Удаление Подсвеченной Части 

5. Настройте Анализ Чувствительности, как показано на следующем рисунке. 

 
Рисунок 59: Анализ Чувствительности 

6. Рассчитайте Анализ Чувствительности и изучите график результатов. 

 
Рисунок 60: График Результатов 

7. Обратите внимание на абсолютные угловые значения графика, показывающие осцилляцию 
приблизительно + /- 35°. Поэтому, общая осцилляция близка к 75°. Вентилятор использует минимум 
45°. 

Задача 8. Проверить сборку на соответствие исходным требованиям проекта в части конструктивных 
изменений. 
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1. Измените параметры в Компоновке для проверки варианта вентилятора в настенном исполнении. 
Подсказка: Измените параметр TILT_ANGLE на 90°. 

 
Рисунок 61: Настенное Исполнение Вентилятора 

2. Восстановите угол и измените TILT_AXIS_HEIGHT на 24.0. 

 
Рисунок 62: Изменение Высоты 

3. Верните значение высоты в 3.50. 

Задача 9. Создать покомпонентное изображение. 

1. Создайте покомпонентное изображение EXP_ALL 
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Рисунок 63: Покомпонентное Изображение Сборки 

2. Создайте покомпонентное изображение EXP_SUB. 

 
Рисунок 64: Создание Определенного Покомпонентного Изображения 

Задача 10. Проверить сборку на соответствие исходным требованиям проекта по габаритным 
размерам. 

1. Откройте деталь BOX. 

2. Объявите деталь в Компоновку и свяжите значения максимальной высоты, ширины и глубины с 
соответствующими размерами коробки. Регенерируйте модель. 

3. Соберите коробку в сборку высокого уровня. Используйте одну зависимость Automatic для 
основания, затем используйте функциональность динамического перемещения компонентов для 
проверки, входит ли сборка в коробку. 
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Рисунок 65: Использование Функциональности Динамического Перемещения Компонентов 

 
Рисунок 66: Завершение Перемещения 

4. Завершите перемещение, используя зависимости фиксации и, затем, подавите деталь BOX. 

Задача 11. Сохранить проект. 
1. Сохраните завершенную сборку. 
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Глава 17 
Разрешение Конфликтов 
В этой главе Вы изучите Среду Разрешения Конфликтов и предлагаемые методы 
Pro/ENGINEER для регенерации конфликтных элементов. 

Цели 
После завершения этой главы, Вы научитесь: 

• находить причину неудачной регенерации. 

• Устранять причину конфликта регенерации 

По причине параметрического характера Pro/ENGINEER, при проведении изменений в модели 
конструкции на любом уровне, они автоматически проводятся во всей сборке. При этом создаются 
зависимости, называемые отношениями родитель / потомок. В случае возникновения конфликта или 
нарушения отношений, происходит ошибка регенерации. 

Причины Ошибок Регенерации 
Когда Pro/ENGINEER не может регенерировать элемент, это означает, что он не может построить 
геометрию модели. Обычно проблема возникает по причине изменения элемента, который теперь 
противоречит или сводит на нет другие элементы, как следующих случаях: 

• элемент не может быть определен и остается не присоединенным. 

• Восстанавливаемый элемент конфликтует с другим. 

• Пересечение элемента больше недействительно, так как изменения размеров переместили 
поверхности пересечения. 

• Привязка потеряна потому, что был переопределен или удален родительский элемент или 
компонент. 

• Элемент определяется неправильно. 

• Модель больше не удовлетворяет ограничениям массива. 

• Новая геометрия недействительна для определения элемента. 

• Компонент отсутствует. 

Среда Разрешения Конфликтов 
Pro/ENGINEER всегда проверяет геометрию модели в процессе регенерации элементов. В случае 
возникновения ошибки регенерации, необходимо разрешить проблему перед продолжением 
обработки модели для того, чтобы защитить назначение конструкции модели. 

Адресование Проблемы 
После входа в Среду Разрешения Конфликтов (Resolve Environment), можно адресовать проблему, 
используя любой из следующих методов: 

• отменить все изменения, сделанные с момента последней успешной регенерации. 

• Обнаружить причину конфликта в модели, используя текущую (конфликтную) модель или 
резервную копию. 
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• Попытаться «быстро исправить (quick fix)» проблему, используя сокращенное выполнение 
стандартных операций только над конфликтным элементом. 

• Изменить конфликтную модель или ее резервную копию, используя функциональность 
стандартной детали или сборки 

Определение Причины 
Зачастую, наиболее эффективной задачей, выполняемой для разрешения проблем регенерации, 
является определение того, почему элемент потерпел неудачу при регенерации. Если информации, 
предоставляемой системой в окне DIAGNOSTICS, не достаточно, можно использовать меню 
INVESTIGATE (ИССЛЕДОВАТЬ) для вызова других инструментов, которые могут помочь определить 
причину. 

Дополнительно к использованию этих инструментов, необходимо определить, как конфликтный 
объект был построен, потенциальные ограничения использовавшегося метода и, которые из этих 
направлений являюется источником конфликта. 

Исправление Ошибок 
Метод, используемый для разрешения ошибки регенерации, зависит от информации, получаемой при 
исследовании проблемы. Если принято решение, что не следует делать первоначальные изменения, 
можно использовать опцию Fix Model или Quick Fix для отмены всех изменений и возвращения 
модели в ее первоначальное состояние. 

Работа Только с Конфликтными Элементами 
Опция Quick Fix, позволяет использовать сокращенный метод работы только с конфликтным 
элементом. Используя меню QUICK FIX, можно переопределить, перенаправить, удалить или 
подавить элемент. 

Обратите внимание: 
Подавление элементов и компонентов - легкий путь для выхода из меню RESOLVE. Однако, 
необходимо исправить проблему для восстановления подавленных элементов или компонентов и 
продолжать работу над проектом. 

Работа с Любым Элементом 
Опция Fix Model позволяет работать с любым элементом в текущей или резервной модели. 
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Примеры Проблем Регенерации 
Таблица 1 перечисляет восемь типичных сценариев возникновения конфликта и возможное решение 
для каждого. Последующий пример иллюстрирует, как разрешать конфликт, возникающий из за 
отсутствующего компонента и привязок отсутствующего элемента. 

Таблица 1: Ошибки Регенерации и Возможные Решения 

Тип Конфликта: Возможное Решение: 
Не присоединенный элемент: направление 
создания элемента - вне твердотельной 
модели. 

Переопределить направление создания элемента, 
чтобы оно указывало внутрь твердотельной модели. 

Не присоединенный элемент: не замкнутое 
сечение элемента выдавливания 
уменьшает ограничительную поверхность. 

Переопределить сечение элемента с тем, чтобы 
сделать его замкнутым. 

Система восстанавливает элемент, 
конфликтующий с другим элементом. 

Используйте Fix Model для подавления или удаления 
первого регенерированного элемента или используйте 
Quick Fix и Reroute или Redefine для выбора новых 
привязок. 

Некорректное определение элемента: 
толщина оболочки превышает радиус 
кривизны поверхности. 

Используя меню Info, создайте сеть (mesh) со 
смещением для определения максимально допустимой 
толщины. Используйте Quick Fix для изменения 
толщины оболочки. Используйте Fix Model для 
изменения радиуса кривизны элемента. 

Ограничения массива больше не 
удовлетворительны 

Используйте Quick Fix и Redefine для изменения опций 
массива на Varying или General. 

Компонент отсутствует. Используйте Quick Fix и Find Component для вызова 
потерянного компонента. 

Используйте Quick Fix и Quit Retr для останова вызова 
сборки; затем, найдите файл компонента и вызовите его 
в сессию, или переместите файл в каталог сборки. 
Настройте путь поиска к потерянному компоненту. 

 
Рисунок 1: Сборка Клапана 

На следующем рисунке показана сборка клапана, которая была создана другим пользователем. При 
ее вызове для проведения изменений, система автоматически переходит в Среду Разрешения 
Конфликтов. 
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Рисунок 2: Конфликт по Причине Отсутствия Компонента 

Окно FAILURE DIAGNOSTICS идентифицирует конфликт по причине отсутствия компонента. При 
повторном вызове сборки, отображается окно FAILURE DIAGNOSTICS, как показано на следующем 
рисунке. Система идентифицирует этот конфликт по причине отсутствия привязок третьего 
компонента. 

 
Рисунок 3: Конфликт из-за Отсутствующих Привязок Элемента 

При использовании Redefine в меню QUICK FIX для изменения привязок к поверхности вала, вторая 
зависимость показывает отсутствие привязки. После определения отсутствующей привязки сборки, 
она регенерируется успешно. 
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Рисунок 4: Диалоговое Окно COMPONENT PLACEMENT 

Лабораторный Практикум 

Цель 
В этом практикуме, Вы используете режим разрешения Конфликтов для исследования 
причин конфликта элемента в модели. 

Метод 
В следующих упражнениях Вы искусственно создадите конфликт в модели. Вы должны будете 
сосредоточиться на том, как найти причину произошедшего конфликта и, затем, используете 
доступные инструменты для исправления проблемы. 
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УПРАЖНЕНИЕ 1: Разрешение Конфликтов Элементов 

 
Рисунок 5: Деталь Воздухоочистителя RS До и После Изменений 

Задача 1. Вызвать воздухоочиститель и определить, как он был создан. 

1. Перейдите в соответствующий рабочий каталог. 

2. Выберите AIR_CLEANER_RS.PRT. 

3. Щелкните по Utilites > Model Player для проигрывания истории создания модели. 

4. Щелкните по  для выбора элемента #4 (BASE_PROTRUSION) на экране или из Дерева Модели. 

Затем выберите  для прокрутки вперед. 

 
Рисунок 6: Проигрыватель Модели 

Задача 2. Измените основание твердотельной модели, заменяя касательные дуги на некасательные 
дуги. 

1. Щелкните правой кнопкой мыши по BASE-PROTRUSION в Дереве Модели. Щелкните по Redefine. 

2. Дважды щелкните по Section. Щелкните по Sketch. 

3. Удалите две дуги, касательные на концах. Выберите одну из дуг. Нажмите <DELETE> на 
клавиатуре. Щелкните по Yes в области сообщения. Удалите вторую дугу. Щелкните по Yes для 
удаления привязки. 

4. Нарисуйте две новые некасательные дуги по 3 точкам и образмерьте их соответственно. 
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Рисунок 7: Изменение Сечения 

5. Щелкните по View > Default. 
Совет: 
Для быстрого перехода к виду по умолчанию, можно нажать <CTRL> < D> . 

6. Завершите переопределение. Щелкните по  > ОК. 

Задача 3. Модель не регенерируется. Найти конфликтный элемент и определить причину. 

1. Рассмотрите окно FAILURE DIAGNOSTICS. Прочтите информацию, которую Pro/ENGINEER 
отображает относительно конфликтного элемента. 

2. Для дальнейшего исследования извлеките информацию по элементу. Щелкните по Feature Info в 
окне FAILURE DIAGNOSTICS. Просмотрите различные атрибуты элемента. Обратите внимание на то, 
что отсутствуют привязки скругления. 

Задача 4. Конфликтный элемент - скругление боковой кромки. Иногда бывает выгодно работать с 
резервной моделью для исследования и, даже, разрешения конфликта в модели. Используйте 
резервную копию для разрешения конфликта. 

1. Щелкните по Investigate > Backup Model > Confirm. Отображается диалоговое окно OPEN. Дважды 
щелкните по AIR_CLEANER_RS.PRT. Щелкните по Roll Model > Before Fail. 
2. Отобразите привязки, используемые для конфликтного элемента. Щелкните по Show Ref. 
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Рисунок 8: Исследование Привязок 

3. Выберите EDGE ID 223. Обратите внимание на подсвечивающуюся кромку модели. 

4. Щелкните правой кнопкой мыши по EDGE ID 223. Щелкните по Info. Закройте Information Window. 

5. Щелкните правой кнопкой мыши по EDGE ID 34. Щелкните по Entity Info. Закройте Information 
Window. 

6. Круговые кромки не подсвечиваются, потому что они являются потерянными привязками. Закройте 
диалоговое окно. 

Задача 5. Скругление конфликтует, потому что была удалена круговая кромка, к которой 
привязывалось скругление и была нарисована новая. Измените окружность, чтобы она была 
привязана к новым кромкам. 
1. Переопределите привязки, используемые окружностью. Щелкните по Quick Fix > Redefine > 
Confirm. 
2. Дважды щелкните по References. Щелкните по Confirm. 

3. Выберите кромки дуги, которые не подсвечиваются. Щелкните по Done . 

4. Введите [.4]. Выберите Preview; затем ОК. 

Задача 6. Элемент скругления успешно регенерируется, но в процессе регенерации начинает 
конфликтовать следующий элемент. Определите причину конфликта. 
1. Щелкните по Investigate> Backup Modl > Confirm > Open > Roll Model > Failed Feat > Show Ref. 
Опорная ось A_2 была создана через цилиндрическую торцевую поверхность на детали. Обратите 
внимание, что четыре отверстия являются дочерними по отношению к этому элементу и не могут быть 
регенерированы. 
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Рисунок 9: Привязки Резервной Модели 

2. Закройте Reference Information Window. 

3. Щелкните по Investigate> Current Modl > Show Ref для просмотра различий. Привязка A_2 теперь 
помечена как отсутствующая. 

 
Рисунок 10: Привязки Текущей Модели 

4. Щелкните по Quick Fix > Reroute > Missing Refs > Done. Выберите поверхность вращения для 
привязки оси на левой стороне детали. 
5. Автоматически перенаправьте все дочерние элементы. Щелкните по All Children. 
Задача 7. Теперь конфликтует идентичный массив. Измените тип массива. 
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1. Щелкните по Fix Model > Modify > Value. Выберите первый элемент Pattern(Cut) в Дереве Модели. 
Выберите размер смещения выреза (1.50) и измените его на 0.75. Также измените количество 
вырезов в массиве с 5 на 3. 

 
Рисунок 11: Изменение Массива 

2. Щелкните по Regenerate. 

Задача 8. Изменить опции массива, используя среду Разрешения Конфликтов (Resolve). 

1. Не выходите из среды Resolve. Щелкните по No для повторного входа в меню RESOLVE. 

2. Щелкните по Fix Model > Feature > Redefine. Выберите массив вырезов из Дерева Модели. 
3. В диалоговом окне дважды щелкните по Pattern. Щелкните по Pat Options > Varying > Done > 
Done/Return > OK. 
4. Щелкните по Done/Return для выхода из среды RESOLVE. 

Задача 9. Можно не входить в среду Разрешения Конфликтов, если учесть предупреждение системы 
при удалении дуг. Вместо этого, замените старые объекты привязки сечения на новые эскизные 
объекты. Верните базовое выдавливание к его первоначальной форме. 

1. Щелкните правой кнопкой мыши по базовому выдавливанию в Дереве Модели. Щелкните по 
Redefine. 

2. Дважды щелкните по Section. Щелкните по Sketch. 

3. Нарисуйте две дуги, касательные на концах, как показано на следующем рисунке, но не удаляйте 
некасательные дуги. 

 
Рисунок 12: Эскиз для Замены 

4. Щелкните по Edit > Replace. Выберите одну из новых созданных дуг; затем выберите ближайшую 
не касательную дугу. Щелкните по Yes, если система запросит удалить размер. Обратите внимание, 
что исходная дуга автоматически удаляется. 

Обратите внимание: 
Одна дуга имеет радиусный размер. При выборе этой дуги, необходимо щелкнуть по Yes для 
подтверждения удаления размера. 
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5. Замените другую дугу и завершите переопределение. 

6. Щелкните по  > ОК. 

7. Сохраните модель и сотрите ее из оперативной памяти. 

УПРАЖНЕНИЕ 2: Разрешение Конфликтов в Сборке 
Задача 1. Открыть сборку карбюратора. Поскольку система вызывает сборку в память, она сообщает 
о всех возникающих проблемах в области сообщения. В верхней части экрана отображается окно 
FAILURE DIAGNOSTICS. Просмотрите информацию в окне. 

1. Откройте CARBURETOR_RESOLVE.ASM. 

2. Щелкните по Master Rep > OK. 

3. Щелкните по Feature Info. Система показывает, что конфликтным элементом является 
CARB_BOWL.PRT и причину конфликта. 

Задача 2. Компонент кофликтует по причине отсутствия модели. Деталь отсутствует в текущем 
каталоге, и при этом не имеется пути, установленного к каталогу, в котором она находится. Укажите 
местоположение отсутствующего компонента, вызовите его вручную и верните его назад в каталог 
RESOLVE. 

1. Щелкните по Quick Fix > Find Component. 
2. Откройте CARB_BOWL.PRT в каталоге MOVED_COMP. 

3. Щелкните по Yes. Теперь вызов сборки завершен. 

4. Откройте CARB_BOWL.PRT щелчком правой кнопки мыши в Дереве Модели. Затем щелкните по 
File > Backup. Каталог RESOLVE должен быть текущим, чтобы система автоматически выбирала его. 
Щелкните по ОК. 

5. Щелкните по File > Erase > Current. Щелкните по Yes. 

Задача 3. Так как деталь находится в том же каталоге, что и RESOLVE_CARBURETOR.ASM, то при 
повторном вызове сборки конфликта не произойдет. 

1. Снова откройте CARBURETOR_RESOLVE.ASM. 

2. Щелкните по  > LEFT. Модель должна отобразиться, как показано на следующем рисунке. Форма 
подкладки должна соответствовать форме воздухоочистителя по бокам, но не соответствует. 

 
Рисунок 13: Установка Вида 

Обратите внимание: 
Обратите внимание, что форма подкладки не соответствует воздухоочистителю в предыдущем виде. 

3. Щелкните по Regenerate > Automatic. 

Задача 4. Регенерация в сборке не выполняется. Исследуйте причину ошибки. 

1. Прочитайте окно DIAGNOSTICS. Оно показывает, что компонент подкладки имеет 
недействительную внешнюю привязку. Определите, почему она конфликтует. Щелкните по Investigate 
в меню RESOLVE FEAT. 

2. Укажите привязки элемента. Щелкните по Show Ref. 
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Рисунок 14: Отсутствующие Привязки 

3. Выберите действительные привязки в окне PARENTS. Обратите внимание на две отсутствующих 
привязки. 

4. Закройте диалоговое окно. 

Задача 5. Переопределить сечение конфликтного элемента. 

1. Щелкните по Quick Fix > Redefine > Confirm. 

2. Дважды щелкните по Section. Щелкните по Sketch. 

Задача 6. Система отображает окно привязки с существующими и отсутствующими привязками. 
Pro/ENGINEER не может найти внешнюю привязку для этих дуг, потому что базовый элемент 
воздухоочистителя был переопределен вне контекста сборки. Измените сечение для привязки его к 
форме воздухоочистителя. 

1. Выберите две MISSING REFERENCES в диалоговом окне и щелкните по Delete. Щелкните по 
оставшимся двум привязкам, затем щелкните по Update. Выберите две кромки в качестве 
дополнительных привязок, как показано на следующем рисунке. Закройте диалоговое окно. 
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Рисунок 15: Использование Кромки Воздухоочистителя 

2. Замените касательные дуги в эскизе не касательными дугами. Увеличьте масштаб отображения 
левой части модели. 

 
Рисунок 16: Левая Часть Модели 

3. Нарисуйте дугу по 3 точкам. 

4. Повторить процесс для правой части модели. 
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Рисунок 17: Определите привязку в Правой Части 

5. Щелкните по Edit > Replace. Выберите последнюю эскизную дугу; выберите исходную касательную 
дугу. Щелкните по Yes. 

6. Повторите процесс для левой части. 

7. Обрежьте горизонтальные линии по новым некасательным дугам. Щелкните по . 

8. Выберите новую дугу и линию в этих четырех углах для создания замкнутого контура. 

9. Щелкните по  > ОК. 

10. Щелкните по Yes для выхода из среды Разрешения Конфликтов. 

 
Рисунок 18: Завершенное Сечение 

Обратите внимание: 
Опция Replace заменяет внутренние привязки в детали, а также внешние привязки. 

11. Сохраните сборку и сотрите ее и связанные модели из памяти. 

Резюме 

В этой главе Вы узнали: 

• как исследовать причину конфликта. 

• Как разрешить конфликт элемента в режимах детали и сборки. 

• Как предохранить элементы от конфликтов, используя Регенерацию. 
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Глава 18  
Pro/PROGRAM 
В этой главе Вы изучите, как использовать Pro/PROGRAM для автоматизации проекта и 
создания различных вариантов, путем включения пользовательских запросов в цикл 
регенерации модели. 

Цели 
После завершения этой главы, Вы научитесь: 

• автоматизировать процесс конструирования деталей и сборок в Pro/PROGRAM. 

• Включать изменения в программу. 

• Запускать и редактировать программу. 

• Использовать Pro/PROGRAM для манипулирования элементами деталей из сборок. 

Различия Между Pro/PROGRAM и Таблицами Семейства 

Таблицы Семейств эффективны, если известны варианты проекта или, есть уверенность, что они не 
будут изменяться, как в библиотеках деталей. 

Pro/PROGRAM особенно полезна, если заранее не известны варианты проекта. 

 
Рисунок 1: Варианты Пользовательского Шкафа 

Структура Программы 
Pro/ENGINEER записывает программу для каждой детали и сборки в той последовательности, в 
которой создается модель. Программа фактически является сценарием действий Pro/ENGINEER в 
процессе регенерации. Для построения вариантов проекта, можно вызывать эту программу и 
управлять ею. Каждая программа имеет пять разделов: 

• Заголовок (Header). 

• Ввод (Input). 

• Уравнения (Relations). 

• Раздел Модели (Model Section). 

• Масс-инерционные характеристики (Massprops). 
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Автоматизация Процесса Конструирования Детали 
Для использования Pro/PROGRAM с целью автоматизирования процесса конструирования детали, 
сначала создается родовая модель как базовая для вариантов конструкций и включаются все 
элементы, необходимые для любого из вариантов конструкции. 

Выполните следующие задачи для настройки автоматизации проектирования детали: 

• Добавление входных операторов. Используя раздел Input программы, создайте запрос для 
ввода соответствующей информации, используя следующий стандартный формат: 

Parameter_Name Parameter_Type

“prompt that you want displayed in the

message window”

• Запись уравнений. Используя уравнения, можно управлять моделью и передавать 
информацию от операторов ввода в параметры модели. 

• Отредактируйте раздел модели. Можно редактировать путем добавления логических 
операторов. Вообще, оператор "if" добавляется к элементам модели на основании входных 
операторов и отношений. 

Ниже приведен пример отредактированного файла программы. Дополнения в программе обозначены 
при помощи "�". 

Листинг Детали Side_Panel 
INPUT

• HEIGHT NUMBER

• "WHAT IS THE SIDE PANEL HEIGHT"

• D2 NUMBER

• "WHAT IS THE SIDE PANEL WIDTH"

• MATERIAL STRING

• "WHAT TYPE OF WOOD IS THE SIDE PANEL"

• DRAWER_CUT YES_NO

• "DOES THE SIDE PANEL SUPPORT A DRAWER"

END INPUT

RELATIONS

• D3=HEIGHT

END RELATIONS

ADD FEATURE (initial number 1)

INTERNAL FEATURE ID 1

TYPE = DATUM PLANE

NAME = DTM1

END ADD

ADD FEATURE (initial number 2)

INTERNAL FEATURE ID 3

TYPE = DATUM PLANE

NAME = DTM2

END ADD

ADD FEATURE (initial number 3)

INTERNAL FEATURE ID 5

TYPE = DATUM PLANE

NAME = DTM3

END ADD

ADD FEATURE (initial number 4)
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INTERNAL FEATURE ID 7

PARENTS = 1(#1) 5(#3) 3(#2)

PROTRUSION: Extrude

NO. ELEMENT NAME INFO STATUS

--- ------------ -----------------

1 Attributes One Side Defined

2 Section Sk. plane - Surface DTM2 Defined

3 Direction Defined

4 Depth Blind, depth = 1 Defined

SECTION NAME = S2D0015

FEATURE’S DIMENSIONS:

d2 = 18.00

d3 = 30.00

d4 = 1.00

END ADD

• IF DRAWER_CUT==YES

ADD FEATURE (initial number 5)

INTERNAL FEATURE ID 28

PARENTS = 1(#1) 5(#3) 7(#4)

CUT: Extrude

NO. ELEMENT NAME INFO STATUS

--- ------------ ------------

1 Attributes One Side Defined

2 Section Sk.plane - Surface feat #4 Defined

3 MaterialSide Inside section Defined

4 Direction Defined

5 Depth Blind, depth = 0.25 Defined

SECTION NAME = S2D0016

FEATURE'S DIMENSIONS:

d6 = 2.00

d7 = 4.00

d8 = 2.00

d9 = .25

END ADD

• ENDIF

MASSPROP

END MASSPROP

Автоматизация Процесса Проектирования Сборки 
Используя программы для регенерации сборки, можно обмениваться различными компонентами и 
сообщать информацию в программу детали. Для настройки автоматизации конструирования сборки, 
выполните те же задачи, которые выполняются для автоматизации проектирования детали, как 
показано: 

• добавить вводные операторы (input statements). 

• Записать уравнения. 

• Отредактировать раздел модели. 
WIDTH NUMBER

"WHAT IS THE WIDTH OF THE CABINET"

HEIGHT NUMBER
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"WHAT IS THE HEIGHT OF THE CABINET"

DEPTH NUMBER

"WHAT IS THE DEPTH OF THE CABINET"

WOOD_TYPE STRING

"WHAT TYPE OF WOOD IS THE CABINET"

DRAWER YES_NO

"DOES THE CABINET HAVE A DRAWER"

IF DRAWER==YES

D_SIZE STRING

"WHICH DRAWER SIZE (DR_8, DR_12, OR DR_16)"

END IF

 

Выполнение Программы Низкого Уровня 
Можно использовать оператор EXECUTE�END EXECUTE для запуска программы нижнего уровня 
(деталь или узел) внутри сборки высокого уровня. Ниже приведен пример параметров сообщений, 
использующих операторы запуска. 
EXECUTE PART SIDE_PANEL

HEIGHT = HEIGHT

D2 = DEPTH

MATERIAL = WOOD_TYPE

DRAWER_CUT = DRAWER

END EXECUTE

Обмен Компонентами 
При замене одного компонента на другой, можно использовать вхождения таблицы семейства 
компонента или узла для замены родовой модели на любое из ее вхождений, как показано: 

 
Рисунок 5: Таблица Семейства для Пользователя (Drawer) 

При настройке параметра и использовании его в программе, система автоматически выбирает 
соответствующее вхождение. Также добавляется оператор ввода, чтобы система вручную запросила 
указать вхождение при запуске программы. Ниже приведен пример со входным параметром указания 
размера для определения требуемого вхождения. 
ADD PART (D_SIZE)

INTERNAL COMPONENT ID 27

PARENTS = 15(#9) 11(#5)

END ADD
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Включение Изменений в Программу 
При выходе из редактора после проведения изменений в программе, система автоматически 
проверяет использование надлежащего синтаксиса. Если система находит ошибку, то она требует 
исправить ее редактированием программы. 

Запуск Программы 
После присоединения программы, Pro/ENGINEER автоматически запускает ее. Однако, ее можно 
запустить в любое время простой регенерацией модели, так как она является простым сценарием 
шагов регенерации. Поскольку раздел ввода больше не пустой, система запрашивает указать один из 
следующих методов для получения значений запросов: 

• ввести новые значения. 

• Работать с существующими значениями. 

• Считать значения из текстового файла. 

Обратите внимание: 
После запуска программы, можно сохранить эту версию модели на постоянной основе, используя 
опцию Instantiate в меню PROGRAM. Система добавляет вхождение к таблице семейства для этой 
версии. 

Редактирование Программы 
Для облегчения поиска ошибок, работайте с одной задачей за раз. Включите изменения и, затем, 
запустите программу для проверки каждого шага. Для облегчения редактирования, используйте 
следующие методы: 

• при переименовании элементов используйте опцию Names в меню SETUP. Затем, система 
отображает название в разделе для этого элемента. Можно использовать функцию поиска 
редактора для нахождения элемента. 

• Для изменения названия символа размера используйте опцию Symbol в меню DIM 
COSMETICS. Это облегчает запись и интерпретацию уравнений. 

• Добавляйте комментарии к программе, используя /*. Любой комментарий, добавленный между 
строками ADD и END ADD отображается в окне Feat Info для этого элемента. 

Управление Элементами, Используя Pro/PROGRAM 
Pro/PROGRAM можно также использовать для управления элементом в модели следующими 
способами: 

• Удалить элемент или компонент. Удалите все строки между и включая ADD и END ADD для 
этого элемента или компонента. 

• Переупорядочить элемент или компонент. Вырежьте все строки между и включая ADD и 
END ADD для этого элемента или компонента и вставьте их в другом месте программы. 

• Подавить элемент или компонент. Добавьте слово SUPPRESSED после слова ADD для 
этого элемента или компонента. 

• Восстановить элемент или компонент. Удалите слово SUPPRESSED в операторе ADD для 
этого элемента или компонента. 

• Изменить размер. Добавьте слово MODIFY перед этим размером в разделе модели 
программы, затем введите новое значение для этого размера. 

• Пауза в регенерации. Добавьте оператор INTERACT в любом месте раздела модели. В 
процессе регенерации модели, Pro/ENGINEER выполняет паузу в месте оператора INTERACT 
и запрашивает, требуется ли добавить к модели другой элемент. 



Pro/ENGINEER 2001 Углубленный Курс    

- 372 - 

Лабораторный Практикум 

Цель 
В этом практикуме, Вы используете Pro/PROGRAM в процессе проектирования. Вы также 
изучите, как редактировать существующую программу в детали и сборке для изменения 
конструкции. 

Метод 
В Упражнении 1, Вы вызовите программу и измените в ней дизайн обода. Ободы имеют различные 
размеры, дизайн спиц и типы монтажа. 

В Упражнении 2, Вы используете Pro/PROGRAM для автоматизации создания нескольких сборок 
передних подвесок. Будут использованы подвески с различными значениями отступа, а также 
различные диски для тормозов. 

УПРАЖНЕНИЕ 1: Автоматизация Проектирования Детали 

 
Рисунок 7: Завершенные Варианты Колес 

Задача 1. Открыть деталь обода и изучить работу, которая уже была выполнена программой 
моделирования обода. 

1. Перейдите в соответствующий рабочий каталог. 

2. Откройте родовую деталь PGM_RIM.PRT. 

3. Щелкните по Regenerate > Enter > Select All > Done Sel. Ответьте на запрос, вводя собственные 
значения. 

4. Повторите Шаг 3 для построения нескольких вариантов ободов. 

5. Сотрите модель из памяти и, затем, вызовите ее снова. 

Обратите внимание: 
Шаг 5 необходимо выполнить для сохранения последовательной нумерации элементов для 
оставшихся в этом упражнении. 

Задача 2. Создайте запрос для типа присоединения. Обод будет использовать крепление на ушках 
или шпинделе. Обратите внимание, что все отверстия для любого типа включены в модель. 

1. Щелкните по Program > Edit Design. 

2. Добавьте оператор ввода для запроса о типе крепления. 

Обратите внимание: 
При работе под управлением ОС Unix, может потребоваться использование редактора vi. Для 
использования другого редактора, можно установить опцию файла конфигурации 
"pro_editor_command". 
INPUT

RIM_DIA NUMBER

"WHAT IS THE RIM DIAMETER?"
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RIM_WIDTH NUMBER

"WHAT IS THE RIM WIDTH?"

STRAIGHT YES_NO

"DO YOU WANT THE STRAIGHT SPOKES INCLUDED (Y,N)?"

IF STRAIGHT==YES

SIDE STRING

"DO YOU WANT RIGHT OR LEFT HANDED SPOKES (L,R)"?"

END IF

R_CURVED YES_NO

"DO YOU WANT THE RIGHT HAND CURVED SPOKES

INCLUDED (Y,N)?"

L_CURVED YES_NO

"DO YOU WANT THE LEFT HAND CURVED SPOKES INCLUDED

(Y,N)?"

IF L_CURVED==YES | R_CURVED==YES

CURVE_RAD NUMBER

"WHAT IS THE RADIUS OF THE CURVED SPOKES?"

END IF

3. Добавьте оператор "if-else-endif" для элементов отверстия. 
IF MOUNT=="LUG"

ADD FEATURE (initial number 13)

INTERNAL FEATURE ID 589

PARENTS = 88(#5) 4(#2) 14(#4)

HOLE: SKETCH

END ADD

ADD FEATURE (initial number 16)

INTERNAL FEATURE ID 658

PARENTS = 88(#5) 589(#13) 4(#2) 14(#4)

HOLE: SKETCH

END ADD

ELSE

ADD FEATURE (initial number 17)

INTERNAL FEATURE ID 4392

PARENTS = 14(#4) 88(#5)

HOLE: SKETCH

END ADD  
END IF 
4. Выйдите из редактора. 

5. Введите [yes]. Введите новые значения для запросов. Щелкните по Enter. 
6. Щелкните по Mount > Done Sel. Укажите тип крепления. 

Задача 3. Добавить запрос указать количество необходимых отверстий в ушках. Так как запрос 
потребуется только при выборе типа крепления �LUG�, используйте оператор IF во входном разделе 
после данных, введенных ранее. 

1. Щелкните по Program > Edit Design. Добавьте оператор ввода для количества отверстий. 
MOUNT STRING

"WHAT MOUNTING TYPE IS USED (LUG, SPINDLE)?"

IF MOUNT=="LUG"

NUM_HOLES NUMBER
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"HOW MANY MOUNTING HOLES ARE NEEDED?"

END IF

2. Перед записью END RELATIONS, добавьте уравнение для установки количества вхождений в 
массиве (P1), равное входному параметру (NUM_HOLES). 
/* SET THE NUMBER OF MOUNTING HOLES

P1=NUM_HOLES

/* SET SPACING OF BOLT HOLES

D39=360/P1

3. Выйдите из редактора и введите [yes]. 

Задача 4. Сохраните некоторые варианты обода на постоянной основе для использования в будущем. 

1. Вызовите модель. 

2. Щелкните по Enter > Select All > Done Sel. 
3. Введите следующее: 
RIM_DIA = 12

RIM_WIDTH = 6

STRAIGHT = Y

SIDE = R

R_CURVED = N

L_CURVED = N

MOUNT = LUG

NUM_HOLES = 4

4. Щелкните по Program > Instantiate для сохранения варианта. Введите [12X6-AR-4N]. 

5. Выполните регенерацию. 

6. Щелкните по Enter. Выберите SIDE. Щелкните по Done Sel. 
7. Введите [L] для стороны. 

8. Щелкните по Program > Instantiate. Введите [12X6-AL-4N] в качестве имени вхождения. 

9. Повторите этот шаг дважды для добавления следующих наборов данных и сохраните 
используемый вариант: 
INPUTS INSTANCE NAME

RIM_DIA = 12

RIM_WIDTH = 8

STRAIGHT = N

R_CURVED = Y

L_CURVED = N

CURVE_RAD = 3.5

MOUNT = SPINDLE

RIM_DIA = 12

RIM_WIDTH = 8

STRAIGHT = N

R_CURVED = N

L_CURVED = Y

CURVE_RAD = 3.5

MOUNT = SPINDLE

10. Вхождения в таблице семейств созданы. Просмотрите их. Выберите Family Tab. Закройте 
редактор по завершении. 

11. Сохраните модель и сотрите ее из оперативной памяти. 
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УПРАЖНЕНИЕ 2: Автоматизация Конструкции Сборки 
Задача 1. Создать запрос на значение смещения подвески для каждой стороны; затем передайте 
значения вниз по структуре в скелет передней подвески с оператором выполнения. 

1. Откройте PGM_FRT_SUSP_SKEL.PRT. Отобразите модель в режиме Скрытых Линий. 

2. Вызовите вид справа (RIGHT). 

3. Регенерируйте деталь. Обратите внимание, что некоторая работа в программе уже была 
проведена. 

4. Щелкните по Enter > Select All > Done Sel. Введите [6] и [-3] для R_OFFSET и L_OFFSET. Подвеска 
изменяется для отображения перемещения рычагов (linkage). 

5. Закройте окно и откройте PGM_FRT_SUSP.ASM. 

Задача 2. Иногда удобнее управлять программой в скелете подвески на уровне сборки. Используйте 
оператор выполнения для передачи информации из сборки. 

1. Щелкните по Program > Edit Design. 

2. Введите операторы ввода для левого и правого смещения между началом входной записи и концом 
входной записи программы. 

3. Введите оператор выполнения для PGM_FRT_SUSP_SKEL.PRT. В этом операторе выполнения, 
значения параметров сборки R_OFFSET и L_OFFSET передаются в параметры скелета с тем же 
названием. Введите оператор непосредственно перед компонентом скелета, добавленным к сборке. 
См. следующее: 

 
4. Выйдите из редактора и включите изменения. 

Задача 3. Использовать программу для автоматической "выгрузки" компонента в сборку. Создайте 
запрос, которые диски использовать для тормозов. Доступны два стилевых решения, сплошной диск и 
вентилируемый. Между ними уже существует функциональный взаимообмен. 

1. Откройте PGM_RF_WHEEL_HUB.ASM. 

2. Укажите входной запрос типа диска в программе сборки. Щелкните по Program > Edit Design. 
BRAKES STRING

"WHICH DISKS DO YOU WANT (PGM_DISK_SOLID,

PGM_DISK_VENTED)?"

3. Прокрутите вниз до записи ADD PART PGM_DISK_SOLID. Добавьте строки EXECUTE и END 
EXECUTE к программе перед строкой ADD PGM_DISK_SOLID. Удалите имя детали PGM_DISK_SOLID 
и введите на этом месте [BRAKES]. 
EXECUTE ASSEMBLY PGM_BRAKES

END EXECUTE
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ADD PART (BRAKES)

INTERNAL COMPONENT ID 19
PARENTS = 16(#4) 18(#5)
END ADD

Обратите внимание: 
Оператор запуска вызывает сборку взаимообмена в память, чтобы взаимообмен мог происходить 
между двумя компонентами. 

4. Выйдите из редактора и включите изменения. 

5. Введите [pgm_disk_vented] в качестве значения BRAKES. 

Задача 4. Добавьте запрос на вариант дизайна тормозов в сборке передней подвески; затем 
передайте это значение двум сборкам wheel_hub. 

1. Активизируйте окно PGM_FRT_SUSP.ASM. 

2. Щелкните по Program > Edit Design. 

3. Добавьте входной запрос для варианта тормоза. Он должен быть идентичным вводному оператору 
в PGM_RF_WHEEL_HUB.ASM. Этот шаг необходимо закончить перед добавлением оператора 
выполнения. 

4. Только после END RELATIONS добавьте оператор выполнения для передачи значения в узел 
PGM_WHEEL_RF_HUB. 
EXECUTE ASSEMBLY PGM_RF_WHEEL_HUB

BRAKES = BRAKES

END EXECUTE

5. Выйдите из редактора и включите изменения. 

6. Введите [PGM_DISK_SOLID] или [PGM_DISK_VENTED] для параметра BRAKES с целью проверки 
программы. 

7. Выполните регенерацию для построения различных конфигураций подвески. 

8. Сохраните сборку. 

9. {Необязательно} Настройте параметр BRAKES в сборке PGM_LF_WHEEL_HUB, как это делалось 
для правой передней сборки; затем добавьте оператор выполнения в сборке передней подвески для 
передачи параметрической информации. 

10. Сохраните сборку и сотрите все модели из памяти по завершении (используйте Current и Not 
Displayed). 

Резюме 

В этой главе Вы изучили: 
• как автоматизировать процесс проектирования для создания различных вариантов модели на 

уровне детали и сборки. 
• Как запускать программу, используя Regenerate. 
• Как вызывать программу, используя Edit Design. 
• Как внедрять (incorporate) изменения программы в модель. 
• Как модифицировать конструкцию в режиме сборки и детали. 
• Как создавать вхождения семейства таблиц из модификаций. 
• Как использовать Pro/Program для управления элементами. 
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Глава 19 
Механизм и Анимация Проекта 
В этой главе Вы изучите процесс создания Конструкции Механизма и Анимации Проекта. 

Механизм (MDX) позволяет проверять и наглядно демонстрировать подвижность и 
гибкость завершенных деталей в сборке. 

Анимация Проекта (DAO) позволяет создавать пользовательские анимации типа 
последовательности сборки / разборки, видов и перемещения механизма. 

Цели 
После завершения этой главы, Вы научитесь: 

• описывать приложения Механизмов. 

• Описывать основные шаги по созданию Механизмов. 

• Создавать простые механизмы. 

• Перечислять возможности Анимации Конструкции. 

• Создавать простые анимации. 

• Экспортировать анимированные фильмы MPEG. 

Краткий Обзор Механизмов 

• Приложение Механизмов Pro/ENGINEER (MDX) � это пакет эмуляции кинематического 
перемещения, который обеспечивает поведенческий анализ сборки. 

• Посредством легко определенных соединений в процессе создания сборки, MDX позволяет 
строить "интеллектуальную кинематику" в сборке на начальных этапах процесса разработки 
изделия. После завершения сборки, можно исследовать проект, анимируя механизм во всем 
диапазоне движения. 

• Анимация перемещения является не только графическим представлением механизма, но 
также дает техническую информацию, которая может облегчить этапы проектирования, типа 
анализа соударений и синтеза профиля кулачка. 

• Пакет Поведенческого Моделирования (Behavioral Modeling Extension - BMX) может 
использоваться для создания оптимизированной конструкции, основанной на измерении 
геометрии. Если требуется полная эмуляция динамики, сборки, созданные с использованием 
MDX, могут легко использоваться в Pro/MECHANICA Motion. 

• Механизм � мощный инструмент инженера, позволяющий создавать конструкции механизма 
четким построением и связыванием «назначения конструкции» в сборки и подсборки 
механизма. 
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Рисунок 1: Окно Механизма 

Создание Сборок Механизма 

Одним из первых шагов в проектировании механизма является эмуляция движения сборки. Собирая 
подвижные компоненты с использованием связей, можно создавать подвижную систему вместо 
одного жесткого тела. 

Сравнение Связей с Зависимостями 
Подобно зависимостям сборки (assembly constraints), связи сборки (assembly connections) 
используются для соединения компонентов вместе. Типы связи определяются, используя то же 
семейство компонентов сборки, которое использовалось бы в реальной ситуации. Эти компоненты 
сборки включают штифты, подшипники и т.д. 

Каждый тип связи связан с уникальным набором геометрических зависимостей, которые базируются 
на существующих зависимостях, используемых в режиме Сборки Pro/ENGINEER. Например, 
штифтовое соединение содержит две геометрических зависимости: зависимость совмещения осей и 
зависимость совмещения плоскостей. 

Выбор Типа Связи 
Следующая таблица перечисляет восемь доступных типов связи в диалоговом окне Component 
Placement, а также пиктограммы и DOF: 
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Таблица 1: Типы Связи 

 
Обратите внимание: 
В дополнение к этим типам связей, также доступны более сложные связи типа кулачка и паза. 

Моделирование Движения 

Перетаскивание Компонентов Сборки 
Перетаскивание (Dragging) - удобный способ перемещения механизма во всем допустимом диапазоне 
движения. Используя пиктограмму Drag в диалоговом окне DRAG, можно выбрать тело, которое не 
определено в качестве прикрепленного и перетащить его мышью. Можно также перемещать или 
вращать тело относительно оси системы координат. 
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Рисунок 2: Снимки и Зависимости в Диалоговом Окне DRAG 

Ведущие Устройства и Перемещение 
Как часть анализа механизма, можно использовать ведущее устройство (driver) для изучения 
кинематического поведения конструкции. Ведущие устройства ведут себя подобно двигателям в 
которых они прикладывают усилия между двумя телами с единственной степенью свободы (DOF). 
Ведущие устройства можно добавлять к модели, чтобы приготовить ее к анализу движения. 

При конфигурировании ведущего устройства необходимо определить: 

• тип ведущего устройства: Перенос (Translation) или Поворот (Rotation). 

• Спецификация профиля: Положение, Скорость или Ускорение. 

• Амплитуда профиля: Постоянная (Constant), Наклонная (Ramp), Косинусное Ускорение При 
Постоянном Синусе (Sine Constant Acceleration), Циклоидная (Cycloidal), Параболическая 
(Parabolic), Полиномная (Polynomial) или Задаваемая Таблицей (Table driven). 

Каждая амплитуда профиля требует различных способов ввода значений. Амплитуда профиля может 
затем быть начерчена для визуального представления, используя введенные значения. Следующий 
пример - для наклонного ведущего устройства. 
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Рисунок 3: График Наклонного Ведущего Устройства 

Выбор Ведущего Устройства 
Ведущие устройства можно наложить на ось соединения (joint axes) или на геометрические объекты 
типа точек, плоских поверхностей и опорных плоскостей. 

Ведущие Устройства для Оси Соединения 
Ведущие устройства для оси соединения (joint axis) используются для определения относительного 
движения между двумя телами в направлении ось соединения. 

Геометрические Ведущие Устройства 
Геометрические ведущие устройства используются для определения движения (вращение или 
перемещение) в точке или плоскости. Они полезны, когда движение не может быть определено, 
используя ось соединения, например: 

• два тела включены в движение и не соединены непосредственно. 

• Требуемый DOF не может быть удовлетворительным при любом существующем соединении. 

• Требуется сложное трехмерное движение в противоположность единичному перемещению 
или вращению. 

Запуск Механизма 

Использование Механизма включает два фундаментальных шага: определение механизма и создание 
его перемещения. В зависимости от того, используются ли в механизме кулачки или пазы, основные 
шаги по запуску механизма слегка различаются. 
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Механизм без Связей Типа Кулачка и Паза 
1. Создает связи сборки � Сборка компонентов, которые должны перемещаться, используя связи, 
позволяет создавать подвижную систему вместо одного неподвижного тела. 

 
2. Определяет Настройки Оси Соединения (Joint Axis) - Настройки оси соединения можно 
использовать для количественного описания смещение, установки диапазона перемещений и выбора 
конфигурации по умолчанию, используемой в регенерации. 

3. Перемещает сборку. 

• Перемещать сборку интерактивно, используя функциональность Drag � используя 
функциональность Drag можно интерактивно перемещать механизм во всем допускаемом 
диапазоне. 

• Настроить ведущие устройства и запуск перемещения � Приводы позволяют закладывать в 
механизм определенные движения. Механизм будет перемещаться в соответствии с 
назначением конструкции, заложенным в соединения, настройки осей соединения и ведущие 
устройства. 

4. Применяет результаты � Используя результаты перемещения можно выполнять различные типы 
инженерного анализа, а также записывать фильмы и файлы изображений в целях визуализации. 

• Генерировать фильм/изображение. 

• Анализ соударений. 

• Создание Огибающей Движения (Motion Envelope). 

• Создание Кривой Следа (Trace curve) / Кривой Синтеза Кулачка (Cam synthesis curve). 

• График результатов измерения 

5. Выполняет Анализ Чувствительности (Sensitivity studies) и Оптимизации (Optimization studies) 
совместно с ВМХ � Создание наглядного подвижного механизма значительно снижает объем работ 
при настройке выполнения анализа, в противоположность созданию скелета сборки. Построение 
функциональности позволяет непрерывно контролировать параметры в пределах диапазона 
перемещений. 
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Механизма со Связями Типа Кулачок и Паз 
Можно создавать сложные связи типа кулачок и паз одинаковым способом после сборки компонента в 
сборку, используя стандартные связи. Используя связи кулачок и паз, можно передавать движение, 
которое очень трудно выполнить с использованием стандартных связей или скелета. 

 
Рисунок 4: Диалоговое Окно CAM - SLOT FOLLOWER CONNECTIONS 

Введение в Анимацию Конструкции 

Опция Анимации Конструкции Pro/ENGINEER (Pro/ENGINEER ® Design Animation ) позволяет 
создавать анимированные последовательности в Pro/ENGINEER, используя детали, сборки и 
механизмы. 

Используя ключевые кадры (key frames), ведущие устройства и унаследованные соединения 
механизма (inherited mechanism joints), анимации можно легко создавать и управлять ими. Эти 
анимированные последовательности могут использоваться как простой и мощный способ передачи 
сложной информацию по изделию или процессу. 

Использование 
• В качестве анимированных руководств по сборке и разборке. 

• В качестве регламентных процедур. 

• В качестве концепции коммуникационного инструмента по продажам и маркетингу, 
требованиям менеджмента, обзора конструкции. 

• В качестве метода по удаленному обмену информацией. 

Анимация Конструкции ассоциативна; поэтому любые изменения, сделанные в конструкции 
Pro/ENGINEER полностью распространяются во всей анимации, гарантируя современность и 
правильность представленной анимации. 

Также могут быть созданы фотореалистические анимации, комбинируя технологии Рендеринга 
Pro/ENGINEER с Анимацией Проекта. 
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Рисунок 5: Анимация Конструкции Сборки 

Возможности Анимации Конструкции 

Интеграция и Ассоциативность 
Анимация Проекта - интегрированная часть Pro/ENGINEER. Поэтому отсутствуют проблемы передачи 
данных, которые обычно возникают при использовании пакетов трехмерной анимации сторонних 
разработчиков. Пользователи получают выгоду, имея полную ассоциативность и возможность 
взаимодействия с другими продуктами и инструментариями управления данными PTC. Если 
конструкция деталей или сборок изменяется, анимация модернизируется автоматически. 

Последовательности Ключевых Кадров 
Пользователь определяет последовательности ключевых кадров (key frame), которые описывают 
положение и ориентацию деталей и сборок в указанное время. Анимация Конструкции переключается 
между этими ключевыми кадрами для создания плавной анимации. 

Простой "снимок" текущих положений и ориентаций в Pro/ENGINEER помогает легко создавать 
ключевые кадры. 
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Рисунок 6: Диалоговое Окно Key Frame Sequence 

Инструменты Анимации 
Анимация Конструкции предоставляет мощные функциональные возможности манипуляции сборками, 
помогая быстро создавать ключевые кадры путем определения геометрических зависимостей, 
переноса и вращения, путем перетаскивания, фиксацией тела и других инструментов. Это позволяет 
быстро манипулировать положением детали для оперативного построения последовательностей 
ключевых кадров и анимации. 

 
Рисунок 7: Диалоговое Окно DRAG 
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Менеджер Анимаций 
События, ключевые кадры и субанимации (sub-animations) отображаются и управляются удобным в 
работе менеджером анимаций. С этого пульта, пользователи могут быстро и легко определять, 
управлять и изменять любой аспект анимации. 

 
Рисунок 8: Управление Анимацией 

Повторное Использование Механизмов 
Соединения механизмов, используемые для создания и перемещения сборок в Механизме, повторно 
используются Анимацией Конструкции, где они могут быть выборочно активизированы и выключены 
на любой стадии в ходе выполнения последовательности анимации. 

Лабораторные Упражнения 

Цель 
В этом практикуме, Вы получите опыт работы с функциональностью базового механизма и анимацией 
конструкции. 

Метод 
В Упражнении 1, Вы создадите механизм проекта сборки Вентилятора. 

В Упражнении 2, Вы создадите элемент анимации конструкции, повторно используя проект сборки 
Вентилятора. 

Инструменты 
Таблица 2: Пиктограммы Механизма и Анимации 

ПИКТОГРАММА ОПИСАНИЕ 

   Моментальный снимок 

   Установка системы координат 

   Выбор и перетаскивание геометрии 

   Перетаскивание связи 

   Выбор соединений 

   Добавить зависимость 
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   Выровнять зависимости 

   Зависимость фиксации тела 

   Отображение пиктограмм анимации 

   Сборочная зависимость по умолчанию 

УПРАЖНЕНИЕ 1: Создание Базового Механизма 
Задача 1. Подготовиться к созданию механизма и осознать цель упражнения. 

1. Очистите память и перейдите в соответствующий рабочий каталог. 

2. Используйте окно для перехода в каталог MECH_ANIM. Дважды щелкните по файлу mpg для 
проигрывания FINISHED_MECHANISM mpeg. (Или, можно дважды щелкнуть по файлу 
MPEG_PLAYER.EXE и использовать его для проигрывания mpeg). Создание такого движения - цель 
настоящего упражнения. 

3. FINISHED_ANIMATION mpeg. Это цель упражнения. 

Задача 2. Создать новую сборку и собрать базовый узел. 

1. Создать новую сборку с именем MECHANISM, используя шаблон по умолчанию. 

ОБРАТИТЕ ВНИМАНИЕ: 
Структура узлов в папке MECH_ANIM была немного изменена с целью облегчения создания 
механизма. 

2. Соберите сборку MECH_BASE с зависимостью по умолчанию. 

 
Рисунок 9: Базовая Сборка 

3. Откройте сборку MECH_OSCILLATE и подавите HUB, BLADES и CAGE.. 
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Рисунок 10: Подавленные Элементы 

4. Закройте окно MECH_OSCILLATE и активизируйте окно MECHANISM. 

Задача 3. Собрать сборку MECH_OSCILLATE, используя связь. 

1. Начните собирать MECH_OSCILLATE. Используйте мышь для позиционирования приблизительно, 
как показано на следующем рисунке. 

 
Рисунок 11: Позиционирование 

2. Щелкните по , чтобы использовать связи механизма вместо типовых зависимостей. 

3. Обратите внимание, что связью по умолчанию является PIN. Выберите две поверхности, 
показанные на следующем рисунке, для создания Совмещения Осей. 

 
Рисунок 12: Выбор Поверхностей для Совмещения Осей 

4. Выберите две поверхности, показанные на следующем рисунке для выполнения требования 
перемещения. (Эти поверхности будут сопряжены). 
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Рисунок 13: Сопрягаемые поверхности 

Задача 4. Динамически протяните сборку. 

1. Щелкните по ОК. Щелкните по Mechanism > Drag, и выберите вершину основного вала. 

2. Переместите мышь и обратите внимание, как штифтовое соединение привязано в узле. 
Позиционируйте, как показано на следующем рисунке. 

 
Рисунок 14: Расположение Узлов 

Задача 5. Собрать DRIVE_ARM, используя связь. 

1. Соберите DRIVE_ARM, используя соединение Pin. Используйте Механизм для перетаскивания в 
положение, показанное на следующем рисунке. 

Обратите внимание: 
Будьте осторожны при перетаскивании рукоятки двигателя, так как, возможно, будет перемещаться 
сборка MECH_OSCILLATE. Другой метод перемещения состоит в использовании ярлычка Move в 
диалоговом окне Component Placement. При этом перемещается только текущий компонент. 

 
Рисунок 15: Перетаскивание в Местоположение 

Задача 6. Создать первое ведущее устройство. 
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1. Щелкните по Mechanism > Model > Drivers > Add и выберите ось соединения, как показано на 
следующем рисунке. 

 
Рисунок 16: Выбор Оси Соединения 

2. Щелкните по Profile и установите Спецификацию в Velocity. 

3. Оставьте тип амплитуды Constant и введите [36.0] в качестве значения для A. 

4. Щелкните по Graph для просмотра функции, применяемой для этого ведущего устройства. 
Закройте окна Driver Profile и Graph Options. 

5. Назовите Ведущее устройство [AUX] и щелкните по ОК > Close. 

Задача 7. Запустить механизм. 

1. Щелкните по Connect > Run > Yes. 

2. Щелкните по Run Motion > Add, и введите [FAN] в качестве названия. Обратите внимание на длину 
времени 10 секунд. Оставьте все значения по умолчанию и щелкните по ОК. 

Обратите внимание: 
Мы ввели 36 °/сек для угловой скорости и 10 секунд - продолжительность времени. Поэтому мы 
получим 36x10 = 360° угловое перемещение. 

3. Увеличьте масштаб изображения DRIVE_ARM и щелкните по Run. 

 
Рисунок 17: Увеличенный Вид 

4. Закройте диалоговое окно MOTION DEFINITIONS и щелкните по Done-Return > Yes для выхода из 
среды Механизм. 
Задача 8. Собрать LINK с двумя связями. 

1. Соберите LINK с соединением Pin для кронштейна, как показано на следующем рисунке . 
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Рисунок 18: Сборка Связи (Link) со Штифтом (Pin) 

2. Щелкните по  для добавления другой связи. Установите Тип в Cylinder и выберите 
поверхности, как показано на следующем рисунке. 

 
Рисунок 19: Выбор Поверхностей 

Задача 9. Запустить Механизм на проверку взаимопроникновения. 

1. Щелкните по Ok. Затем щелкните по Mechanism > Connect > Run > Yes. 

2. Щелкните по Run Motion > Run. Механизм должен выполнить один полный цикл осцилляции. 

 
Рисунок 20: Запуск Перемещения 

3. Щелкните по Close > Results > Playback. Щелкните по  и выберите LINK и PEDESTAL. 

4. Перерисуйте экран и щелкните по Play. Установите опции в диалоговом окне ANIMATE, как 
показано на следующем рисунке. 
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Рисунок 21: Диалоговое Окно Animate 

5. Щелкните по . Обратите внимание что Link сталкивается с Pedestal в процессе колебания 
деталей. 

 
Рисунок 22: Взаимопересечение Связи 

Обратите внимание: 
Можно изменять масштаб изображения, поворачивать, панорамировать и изменять отображение 
модели и опорных элементов в процессе выполнения анимации. 

6. Щелкните по  и закройте диалоговое окно ANIMATE. 
7. Закройте окно RESULTS PLAYBACK и щелкните по Done-Return > Yes для выхода из среды 
Механизма. 
Задача 10. Установить движение на ведущем вале с рычагом и ведущим устройством. 

1. Выберите деталь F3_Driveshaft и переопределите ее. 

2. Щелкните по  для удаления всех зависимостей. Затем щелкните по . 

3. Совместите оси между следующими двумя поверхностями. 

 
Рисунок 23: Совмещение Осей 
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4. Выполните требования переноса, выбирая две поверхности, показанные на следующем рисунке. 

 
Рисунок 24: Выбор Двух Поверхностей 

5. Щелкните по ОК для завершения переопределения. 

Задача 11. Добавьте второе ведущее устройство. 

1. Щелкните по Mechanism > Model > Drivers > Add и выберите ось соединения, как показано на 
следующем рисунке. Используйте Flip, чтобы пурпурная стрелка указывала внутрь. 

 
Рисунок 25: Выбор Оси Соединения 

2. Введите [MAIN] в качестве названия и щелкните по Profile. 

3. Установите в Спецификации Velocity и введите [108] в качестве значения для �A�, используя 
Constant Magnitude. 

4. Щелкните по Ok > Close. 

Обратите внимание: 
Мы ввели 108 °/сек для угловой скорости и 10 секунд - продолжительность времени. Поэтому мы 
получим 108x10 = 360° угловое перемещение. 

Задача 12. Запустить Механизм. 

1. Щелкните по Connect > Run > Yes. 

2. Щелкните по Run Motion > Edit > Driver. Выберите Ведущее устройство MAIN и щелкните по Add. 

3. Щелкните по ОК и Run. Обратите внимание, что вал теперь вращается в процессе осцилляции. 
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Рисунок 26: Вращение Вала 

Задача 13. Запустить Механизм всей сборки. 

1. Выйдите из среды Механизма и восстановите (Resume) HUB, BLADES и CAGE. 

2. Переопределите (Redefine) HUB. Обратите внимание, что он просто собран со стандартными 
зависимостями вместе с SHAFT. Отмените (Cancel) переопределение (Redefine). 

3. Введите [Mechanism] и щелкните по Run Motion > Run. Просмотрите движение, затем щелкните по 
Close. 

4. Щелкните по Results > Playback. Установите то же взаимопересечение Two Parts, что и прежде, и 
щелкните по Play. 

 
Рисунок 27: Осцилляция Вентилятора 

Задача 14. Необязательно: Записать фильм. 

1. Щелкните по Capture и введите имя файла. Щелкните по Ok. Создание MPEG займет 
приблизительно 10 минут. 

2. Используйте окна для поиска и проигрывания файла фильма. 

Обратите внимание: 
Если имеются сложности с механизмом, можно использовать сохраненный механизм. Сотрите все из 
памяти и откройте FINISHED_MECHANISM.ASM. затем введите результаты воспроизведения 
механизма и регенерируйте файл FINISHED_FAN.PBK. 
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УПРАЖНЕНИЕ 2: Создание Анимации 
Задача 1. Приготовиться к созданию анимации. Просмотреть завершенный фильм MPEG. 

1. Очистите всю память и измените рабочий каталог на MECH_ANIM, в случае необходимости. 

2. Используйте окно для перехода в каталог MECH_ANIM. Дважды щелкните по файлу mpg для 
проигрывания FINISHED_MECHANISM mpeg. (Или, можно дважды щелкнуть по файлу 
MPEG_PLAYER.EXE и использовать его для проигрывания mpeg). Создание такого движения - цель 
настоящего упражнения. 

3. Закройте проигрыватель Mpeg и вернитесь в Pro/ENGINEER. 

4. Откройте ANIMATION.ASM. 

 
Рисунок 28: Сборка для Анимации 

5. Щелкните по Applications > Animation. 

6. Щелкните по  >  > ОК для отображения локальной системы координат. 

7. Создайте сохраненный вид с названием [cage_blades], как показано на следующем рисунке. 

 
Рисунок 29: Вид Лопастей в Корзине 

8. Создайте сохраненный вид с названием [ISO], как показано. 
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Рисунок 30: Вид ISO 

9. Переориентируйте вид, приблизительно, как показано на следующем рисунке и сохраните его под 
именем [start]. 

 
Рисунок 31: Переориентирование Вида 

Задача 2. Инициируйте тела и начните делать снимки 

1. Щелкните по  > . 

2. Щелкните по телу Ground и щелкните по . 

3. Выберите детали MAIN_BASE, SUPPORT_ARM и MOTOR и щелкните по Done Sel > Ok. Закройте 
диалоговое окно BODIES. 

4. Щелкните по  > , чтобы сделать первый снимок. 

5. Щелкните по  и выберите деталь REAR_COVER, чтобы установить текущую Csys. 

Задача 3. Создать набор снимков для корзины и лопастей. 

1. Щелкните по , выберите деталь Cage и протяните в положение, приблизительно показанное на 
следующем рисунке. 
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Рисунок 32: Создание Снимков 

2. Щелкните по  для снятия второго снимка. 

3. Щелкните по  и перетащите первую лопасть в положение, показанное на следующем рисунке. 

 
Рисунок 33: Положение для Третьего Снимка 

4. Щелкните по  для снятия третьего снимка. 

5. Сделайте четвертый снимок, как показано на следующем рисунке. 

 
Рисунок 34: Четвертый Снимок 

6. Сделайте пятый снимок, как показано на следующем рисунке. 
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Рисунок 35: Пятый Снимок 

7. Шестой снимок показан на следующем рисунке. 

 
Рисунок 36: Шестой Снимок 

8. Седьмой снимок показан на следующем рисунке. 

 
Рисунок 37: Седьмой Снимок 

9. Создайте следующий снимок, как показано на следующем рисунке. 
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Рисунок 38: Восьмой Снимок 

Задача 4. Создать сохраненный вид для рычага и сделать его снимки. 

1. Измените масштаб изображения, как показано ниже, и создайте сохраненный вид с названием 
[zoom_link]. 

2. Щелкните по Constraints >  и выберите связи, показанные на следующем рисунке для их 
временной блокировки. 

 
Рисунок 39: Выбор Зависимостей для Блокировки 

3. Щелкните по  > и выберите LINK для установки активной Csys. 

4. Щелкните по , перетащите связь и создайте девятый снимок, как показано на следующем 
рисунке. 
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Рисунок 40: Девятый Снимок 

5. Щелкните по  и протащите для создания десятого снимка, как показано на следующем рисунке. 

 
Рисунок 41: Десятый Снимок 

6. Снимок 11 показан на следующем рисунке. (Подсказка � заблокируйте зависимость и повторно 
выберите Csys.) 

 
Рисунок 42: Одиннадцатый Снимок 

7. Измените масштаб изображения и создайте сохраненный вид [hub_covers], как показано на 
следующем рисунке. 
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Рисунок 43: Новый Сохраненный Вид 

8. Щелкните по  и выберите деталь REAR_COVER, чтобы установить текущую Csys. 

9. Создайте Снимок 12, как показано. 

 
Рисунок 44: Двенадцатый Снимок 

10. Создайте Снимок 13, как показано на следующем рисунке. 

 
Рисунок 45: Тринадцатый Снимок 

11. Создайте Снимок 14, как показано на следующем рисунке. 



Pro/ENGINEER 2001 Углубленный Курс    

- 402 - 

 
Рисунок 46: Четырнадцатый Снимок 

12. Закройте диалоговое окно DRAG. 

13. Щелкните по Utilites Time Domain, и отредактируйте Время Окончания (End Time) до [30] секунд. 
Щелкните по ОК. 

14. Щелкните по  для создания Последовательности Ключевых Кадров (Key Frame Sequence, 
KFS). 

15. Щелкните по  для добавления Снимка 1 в KFS. 

16. Выберите Snapshot2, введите [1.0] в качестве времени и щелкните по . 

17. Добавьте оставшиеся Снимки, как показано на следующем рисунке. 

 
Рисунок 47: Добавление Снимка к Последовательности Ключевых Кадров 

18. Щелкните по ОК и, затем, щелкните по  для проверки анимации. Щелкните по Stop, когда 
временная шкала (timeline) перемещения достигнет 15 секунд. 

19. Переместите ключевые кадры для корзины и лопастей ближе друг другу на временной шкале, как 
показано на следующем рисунке. 
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Рисунок 48: Настройка Временной Шкалы 

20. Щелкните по  для повторной проверки анимации. Щелкните по Stop, когда временная шкала 
(timeline) перемещения достигнет 15 секунд. 

21. Выберите временную шкалу KFS, как показано на следующем рисунке. Щелкните по  > Edit 
KFS. 

 
Рисунок 49: Выбор Временной Шкалы 

22. Отредактируйте время, как показано на следующем рисунке. 

 
Рисунок 50: Редактирование Времени 

Операции с мышью для временной шкалы анимации 
Левая кнопка     - выполнение одиночного выбора 
CTRL + левая кнопка мыши   - выполнение многократного выбора 
Двойной щелчок левой кнопкой мыши  - редактирование объекта 
Перетаскивание левой кнопкой мыши  - редактирование времени 
Перетаскивание средней кнопкой мыши  - редактирование вертикального положения 
SHIFT + левая кнопка мыши   - отмена последней операции 
SHIFT + средняя кнопка мыши  - повтор отмененной операции 
Правая кнопка мыши  - вызов выпадающего меню для выбранного 

объекта 
Рисунок 51: Важное Примечание 

23. Добавьте Снимки 13 - 1 в зеркальную последовательность с момента времени 14 до момента 
времени 23, как показано на следующем рисунке. 



Pro/ENGINEER 2001 Углубленный Курс    

- 404 - 

 
Рисунок 52: Добавление Снимков в "Зеркальную" Последовательность 

24. Щелкните по Ok >  для проверки анимации. 

Задача 5. Добавить виды во временную шкалу. 

1. Щелкните по Utilites > Time Domain для временного редактирования Времени Окончания (End 
Time) до [12] секунд. Щелкните по ОК. 

2. Щелкните по , выберите поименованный вид START, установите значение времени в [0.5] и 
щелкните по Apply. 

3. Выберите поименованный вид Cage_Blades, установите значение времени в [1.5] и щелкните по 
Apply. 

Обратите внимание: 
Все сохраненные виды во временной шкале в этом упражнении должны иметь значение �After�, 
установленное в �START�. 

4. Щелкните по Close >  для проверки анимации. 

5. Щелкните по , выберите вид Cage_Blades, установите значение времени в [4.5] и щелкните по 
Apply. 

6. Примените время [6.0] для вида Zoom_Link. 

7. Применить время [10.0] для вида Zoom_Link. См. рисунок ниже. 

 
Рисунок 53: Изучение Временной Диаграммы 

8. Щелкните по Close >  для проверки анимации. 
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9. Щелкните по Utilities > Time Domain для временного редактирования Времени Окончания (End 
Time) до [20] секунд. Щелкните по ОК. 

10. Щелкните по , выберите вид Hub_Covers, установите значение времени в [10.5] и щелкните 
по Apply > Close. 

11. Щелкните по  в  и выберите Zoom In. Затем выберите окно, как показано на 
следующем рисунке. 

 
Рисунок 54: Выбор Окна 

12. Щелкните по , выберите вид Hub_Covers, установите значение времени в [13.5] и щелкните 
по Apply. Повторите для значения [15.5]. 

13. Выберите вид Zoom_Link, установите значение времени в [16.5] и щелкните по Apply. 

 
Рисунок 55: Установка Значения Времени 

14. Щелкните по Close >  для проверки анимации. 

15. Выберите вид Start, установите значение времени в [19] и щелкните по Apply. 

16. Щелкните по Utilites > Time Domain и отредактируйте End Time до [30] секунд. Щелкните по ОК. 

17. Добавьте вид Start при значении времени [22.5]. 

18. Добавьте вид ISO при значении времени [23.5]. 

19. Щелкните по  на  и выберите Refit. Затем увеличьте масштаб изображения как 
показано. 

 
Рисунок 56: Отображение После Операции Refit 

20. Щелкните по  для проверки анимации. 

Задача 6. Добавить ведущее устройство к шкале времени. 
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1. Щелкните по Animation > Driver > Main > Include. 

2. Перетащите Ведущее устройство (Driver) в следующее местоположение на шкале времени. 

 
Рисунок 57: Перемещение Ведущего Устройства 

Задача 7. Создать фиксацию тело-тело (body-body lock) для продолжительности ведущего 
устройства. 

1. Щелкните по  и выберите F3_DRIVESHAFT в качестве Ведущего тела. 

2. Выберите HUB и BLADES в качестве Подвижных тел (Follower bodies) и щелкните по Apply > Close. 

3. Переместите фиксацию тело-тело на временной шкале, показанной на следующем рисунке. 

 
Рисунок 58: Перенос Фиксации Тела 

4. Добавьте в конце вид START, как показано на следующем рисунке. 

 
Рисунок 59: Заключительный Вид START 

5. Сохраните сборку. 

6. Щелкните по  для проверки анимации. 

7. Щелкните по  для проигрывания анимации. Настройте диалоговое окно, как показано на 
следующем рисунке. 
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Рисунок 60: Диалоговое Окно Animate 

8. Щелкните по  для непрерывного проигрывания анимации. 

9. После просмотра нескольких циклов анимации, щелкните по Capture для экспорта фильма в 
формат MPEG. Введите [Animation] в качестве имени файла, примите все значения по умолчанию и 
щелкните по Ok. Создание Mpeg займет приблизительно 10 минуты. 

Резюме 

В этой главе Вы изучили: 

• как создавать механизм. 

• Как анимировать конструкцию 
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Глава 20 
Создание Фотореалистических 
Изображений 
В этой главе Вы изучите, как создавать фото-реалистические изображения 
твердотельных моделей, используя Pro/PHOTORENDER.. 

Цели 
После завершения этой главы, Вы научитесь: 

• определять и устанавливать соответствующие виды. 

• Определять помещение и настраивать его текстуру. 

• Определять и устанавливать отображение. 

• Устанавливать источники света. 

• Закрашивать сцену, используя различные опции. 

• Манипулировать изображениями. 

Создание Фотореалистических Изображений 

Можно создавать фотореалистические изображения моделей, деталей или сборок Pro/ENGINEER, 
используя Photorender. Он позволяет: 

• настраивать сцену. 

• Закрашивать (Render) сцену. 

• Манипулировать изображениями. 

Интерфейс Photorender 
Все функции, необходимые для установки и закрашивания сцены, можно вызывать из меню 
Photorender. Можно также сохранять и редактировать изображения, запускать и останавливать 
процесс закрашивания используя это меню. Для активизации меню Photorender, щелкните по View > 
Model Setup > Photorender. 

 
Рисунок 1: Меню Photorender 
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Настройка Сцены 

Сцена включает в себя освещенную модель с назначенным ей отображением и средой. Для создания 
сцены требуется: 

• установить соответствующий перспективный вид. 

• Установить окружающее пространство модели. 

• Определить и назначить внешности (appearances). 

• Установить свет, для освещения модели. 

 
Рисунок 2: Сцена для Модели Пресс-Формы 

Настройка Видов и Окружающего Пространства 
В реальной жизни, Мы всегда видим объект с фоном в перспективе. Для создания реалистического 
представления необходимо определить вид, в котором требуется закрасить модель и создать 
окружающее пространство вокруг нее. 

Настройка и Сохранение Видов 
Меню Photorender помогает настраивать и сохранять виды в которых требуется раскрасить модель, 
без выхода из режима Photorender. Pro/ENGINEER отображает модель в триметрическом (trimetric) 
виде по умолчанию. Для увеличения реалистичности, переведите модель в перспективный вид вместо 
триметрического. Перспективные виды можно настраивать, используя меню Photorender. 

 
Рисунок 3: Триметрический и Перспективный Виды 
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Настройка Окружающего Пространства 
Окружающее пространство помогает размещать модель в среде. Оно имеет шесть сторон, которые 
называются Стены (Walls), Пол (Floor) и Потолок (Ceiling). Каждая сторона комнаты может 
независимо перемещаться и позиционироваться относительно модели. Всем сторонам комнаты могут 
быть назначены различные текстуры. Эти текстуры определяют визуальный компонент сцены вокруг 
модели. 

По умолчанию, окружающее пространство отображается в виде каркаса, а Wall2 и Floor отображаются 
с сеткой. Можно выбрать отображение окружающего пространства в тонированном виде. 

 
Рисунок 4: Окружающее Пространство в Каркасном Режиме Отображения 

 
Рисунок 5: Окружающее Пространство в Тонированном Режиме Отображения 

Определение и Настройка Внешности 
Внешности (Appearances) - комбинация множества признаков, которые определяют отображение 
материала типа древесины, стали, золота, каучука и т.д. Эти признаки включают цвет, яркость, 
отражение, прозрачность и отображение и т.д. Можно изменять эти признаки для создания 
внешностей, используя диалоговое окно APPEARANCE EDITOR. 
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Рисунок 6: Различные Внешности 

Для создания сложных внешностей, Photorender позволяет назначать Текстуру, Вмятины (Bump) и 
Переводные Картинки (Decal). 

 
Рисунок 7: Сферы с Различными Назначенными Внешностями 

Внешности можно устанавливать, используя диалоговое окно APPEARANCES. В режиме Детали 
можно назначать внешности для выбранных поверхностей или на всю деталь. В режиме Сборки, 
можно назначать внешности для компонента или на всю сборку. 

Настройка Источников Света 
Хорошая схема освещения увеличивает реализм и визуальное восприятие сцены. По умолчанию, 
Photorender освещает модель двумя источниками света, Рассеянным (Ambient) и Направленным 
(Direction) светом. Для создания качественной раскраски, можно создавать соответствующие 
источники света, используя диалоговое окно LIGHTS. Photorender позволяет создавать четыре типа 
таких источников: 

• Точечный (Point) � точечный источник света подобен лампе накаливания, который излучает 
свет из своего центра во все стороны. 

• Направленный (Direction) - направленный источник света излучает параллельный пучок 
лучей в бесконечность. Он не имеет указанного положения. 

• Прожектор (Spot) � прожектор подобен точечному источнику света, чьи испускаемые лучи 
ограничены конусом. 

Используя диалоговое окно LIGHTS, можно включать / выключать источник света, удалять или 
изменять свойства источника света. 

Можно определять или изменять свойства источника света, используя диалоговое окно LIGHT 
EDITOR. Диалоговое окно LIGHT EDITOR размещает источник света относительно модели, позволяет 
ему отбрасывать тени и управлять цветом. 

Раскрашивание Сцены 

Сцену можно раскрашивать после ее настройки. Система вычисляет отражение, подсветку, 
прозрачность, тени и т.д и создает изображение сцены. 
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Рисунок 8: Раскрашенная Сцена 

Photorender позволяет выбирать множество опций, используя диалоговое окно RENDER 
CONFIGURATION для создания различных визуальных эффектов. Ниже приведены некоторые из 
основных опций, которые можно настраивать, используя диалоговое окно RENDER CONFIGURATION: 

• Render Quality (Качество Закраски) 

• SelfShadows (Собственные Тени) 

• Reflections (Отражения) 

• Render Room (Сцена Закрашивания) 

• Reflect On Floor (Отражение от Пола) 

• Shadows On Floor (Тени от Пола) 

• Geometric Texture Sharpen (Геометрическая Контрастность Текстуры) 

• Manipulating Images (Манипулирование Изображениями) 

Photorender позволяет управлять изображениями, использующими Редактор Изображений (Image 
Editor). 

 
Рисунок 9: Окно Редактора Изображений 
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Некоторые из основных функций, которые можно выполнять с использованием Редактора 
Изображений: 

• конвертирование форматов изображений. 

• Изменение размеров изображений. 

• Зеркальное отображение изображений. 

• Поворот изображений. 

• Создание переводных картинок. 

• Стилизация изображений. 

Лабораторные Упражнения 

Цель 
В этом практикуме, Вы создадите фотореалистические изображения модели 
Pro/ENGINEER. 

Метод 
В Упражнении 1, Вы изучите инструменты Photorender. Вы создадите источники света и окружающую 
обстановку для завершенной сборки вентилятора. 

Инструменты 
Таблица 1: Пиктограммы Photorender 

ПИКТОГРАММА ОПИСАНИЕ 

   Изменение источника света 

   Изменение перспективного вид 

   Закрашивание (Render) модели 

   Изменение внешности 

   Изменение конфигурации окружающего пространства 

   Изменение опций конфигурации окружающего пространства 

    Удаление источника света 

    Создание прожектора 

УПРАЖНЕНИЕ 1: Использование Photorender 
Задача 1. Открыть модель и активизировать Photorender. 

1. Откройте любую из завершенных сборок вентилятора. 
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Рисунок 10: Завершенная Сборка Вентилятора 

2. Щелкните по View > Model Setup > Photorender. 

 
Рисунок 11: Меню Пиктограмм Photorender 

Задача 2. Прямоугольная комната управляет окружающим пространством модели. Система создает 
комнату по умолчанию, которую можно изменять в соответствии с требованиями пользователя. 
Откройте диалоговое окно ROOM EDITOR и ознакомьтесь с комнатой. 

1. Щелкните по  [Изменяет конфигурацию окружающего пространства]. Обратите внимание на 
текстуры по умолчанию, используемые для стен, пола и потолка. 

Обратите внимание: 
Размер комнаты можно изменить, используя колесо прокрутки или текстовое окно. 

2. Щелкните по Close по завершении изучения диалогового окна. 

Задача 3. Внешности отображают деталь с назначенным материалом. Можно определять 
пользовательскую внешность и назначать ее детали или сборке. Познакомьтесь с основами создания 
и настройки внешностей. 

1. Щелкните по  [Изменяет внешность]. Обратите внимание, что Палитра содержит внешность по 
умолчанию. Можно добавлять дополнительные внешности. Можно также назначить внешность, 
используя диалоговое окно APPEARANCES. 

2. Щелкните по Add в диалоговом окне APPEARANCES. Обратите внимание, что ярлычки BASIC, 
ADVANCED и DETAIL содержат несколько признаков, которые можно изменять для создания 
различных внешностей. 

3. Закройте диалоговые окна APPEARANCE EDITOR и APPEARANCE. 

Задача 4. Pro/ENGINEER освещает модель источниками света по умолчанию. Можно создавать 
указанные источники света для управления освещением модели. Откройте диалоговое окно LIGHTS и 
познакомьтесь с созданием и управлением источниками света. 
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1. Щелкните по  [Изменяет источники света]. Обратите внимание на два источника света по 
умолчанию в диалоговом окне Lights. Можно добавлять источники света Point, Spot или Direction, 
используя выпадающее меню или пиктограммы. Можно также редактировать, удалять или 
включать/выключать источники света. 

 
Рисунок 12: Диалоговое Окно LIGHTS 

Задача 5. Создайте новый источник света. 

1. Щелкните по  [Создает прожектор] в диалоговом окне LIGHTS EDITOR. Обратите внимание, что 
можно управлять положением, направлением и углом распространения света в диалоговом окне 
LIGHTS EDITOR. 

2. Щелкните по ОК для закрытия диалогового окна LIGHTS EDITOR. Обратите внимание на новый 
добавленный источник света в диалоговом окне LIGHTS. 

3. Удалите прожектор. Щелкните по  [Удаляет источник света] в диалоговом окне LIGHTS. 

4. Закройте диалоговое окно LIGHTS. 

Задача 6. Закрасьте модель. При закрашивании модели, система вычисляет отражения и тени 
относительно комнаты, внешность и установленные источники света. По умолчанию, система создает 
закрашенную низкокачественную сцену и отображает ее в текущем окне Pro/ENGINEER. 

1. Щелкните по  [Закрасить модель]. Ожидайте, пока система не закрасит модель и не покажет ее 
изображение в окне Pro/ENGINEER. Обратите внимание на отсутствие прозрачности и текстур, даже 
если эти признаки включены. 
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Рисунок 13: Предварительное Закрашивание 

Задача 7. Существует много опций конфигурации для управления закрашиванием модели. Измените 
несколько назначений и снова закрасьте модель. 

1. Временно выйдите из Photorender. Щелкните по  [Закрыть диалоговое окно]. 

2. Щелкните по View > Model Setup > Color and Appearance. 

3. Выберите цвет, используемый для передней и задней крышек, и щелкните по Modify. 

4. Выберите ярлычок ADVANCED и перетащите ползунок Transparency на 50%, как показано на 
следующем рисунке. 

 
Рисунок 14: Изменение Прозрачности 

5. Щелкните по ОК > Close. 

6. Щелкните по View > Model Setup > Photorender. 

7. Щелкните по  [Изменяет опции конфигурации закрашивания]. Установите опции, как показано на 
следующем рисунке. 
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Рисунок 15: Установка Опций 

8. Щелкните по Close и  [Закрашивает модель]. 

9. Подождите, пока система закрасит модель и отобразит изображение в окне Pro/ENGINEER. 
Обратите внимание на прозрачность и отражения основного тела. 

 
Рисунок 16: Закрашивание с Измененными Опциями 

Задача 8. НЕОБЯЗАТЕЛЬНО: Изменить Фон 
1. Следующие два изображения сохранены в папке Project/ Completed /Part III. 

 
Рисунок 17: Компоновка Вентилятора 
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Рисунок 18: Сцена для Экспериментирования 

2. Поэкспериментируйте с опциями Room Setup, чтобы использовать эти изображения в качестве 
текстур фона или стен. 

 
Рисунок 19: Создание Фона 

Резюме 

В этой главе Вы изучили: 

• основные возможности Photorender. 

• Как создавать фото-реалистичные изображения модели с использованием функциональности 
Photorender. 
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